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1)

Users can check their Google Calendars on which
devices?

1. A) Smart phone
2. B) Tablet
3. C) Laptop
4. D) All of the above

Get Certified Now!
2)

Google Calendars work seamlessly with Gmail for
making appointments and scheduling events.

1. A) True
2. B) False

3)

Users of Google Calendars can easily “find a time” to
conveniently schedule meetings with multiple
participants.

1. A) True
2. B) False

Get Certified Now!
4)

Teachers can use the Appointment Slots feature to
allow students and parents to schedule meetings with a
teacher.

1. A) True
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2. B) False
5)

When scheduling a meeting to discuss a document,
one can add an attachment to that event.

1. A) True
2. B) False

6)

Which of the following are true about labels?
1. A) Gmail has labels but not folders
2. B) Email can have multiple labels but can only go in one folder
3. C) Labels can be color coded and are searchable
4. D) All of the above

7)

What do filters do?
1. A) Auto-reply to your messages
2. B) Allow you to manage the flow of incoming messages
3. C) Delete pop-up ads from your messages
4. D) Screen messages for inappropriate content on work devices

8)

What’s a canned response?
1. A) An error message in Gmail
2. B) Spam messages
3. C) A pre-written message you can create and save
4. D) Out of office replies

9)

What are Google Apps?
1. A) Web-based Google Products such as Drive, Gmail and Calendar
2. B) Games for Android devices
3. C) Applications to run Android on desktop operating systems
4. D) Educational applications for mobile devices

10)

How are Google Groups different from Contact
Groups?



1. A) Google Groups create a single usable email address to message groups of people
2. B) Contact Groups only work through your email address’ contact list
3. C) Google Groups can be used to share Google documents with groups of people
4. D) All of the above

11)

What is Google Drive?
1. A) A tablet
2. B) A laptop
3. C) A document creation and storage platform that works in the web browser

12)

You need to click “save” to save your work using Docs,
Sheets or Slides.

1. A) True
2. B) False

13)

What is the best way to convert Microsoft files to
Google Drive files?

1. A) Retype your documents in Google Drive
2. B) Use third-party software
3. C) Click the upload button in Google Drive

14)

What is an advantage to using Google Docs and Drive
in the classroom?

1. A) Easy collaboration with students and teachers
2. B) Cloud storage so documents can be accessed anywhere
3. C) Saves paper
4. D) All of the above

15)

What is the easiest way to share a Google Drive
document?

1. A) Burn it to a CD
2. B) Move it to a USB flash drive
3. C) Use the share feature in Drive
4. D) Saves paper



5. E) All of the above
16)

Who can make websites using Google Sites?
1. A) Administrators
2. B) Beginners
3. C) Teachers
4. D) Students
5. E) All of the above

17)

Only one person can edit a single site in Google Sites.
1. A) True
2. B) False

18)

Students can use Google Sites to keep a digital
portfolio.

1. A) True
2. B) False

19)

Creating a website with Google Sites requires a Google
Apps account.

1. A) True
2. B) False

20)

Who can students share their portfolios with?
1. A) Other students
2. B) Parents
3. C) The world
4. D) All of the above

21)

What is Chrome?
1. A) A word processor
2. B) A web browser
3. C) Voice over Internet Protocol



4. D) A computer language
22)

What can you do in the Omnibox?
1. A) Enter a web address
2. B) Search Google
3. C) Check the weather
4. D) Find the time in a country on the other side of the planet
5. E) All of the above

23)

Why is tabbed browsing helpful?
1. A) It allows the user to track browsing history
2. B) It provides access to restricted sites
3. C) It allows users to have multiple web pages open at the same time in one window
4. D) It limits users to specific web sites

24)

When signing in to Chrome on a new computer, users
must reconfigure all of the custom browser settings.

1. A) True
2. B) False

25)

Where can users find apps and extensions for
Chrome?

1. A) The Google Chrome Web Store
2. B) On the shelves of a local computer retail store
3. C) In your Gmail settings
4. D) In the File menu of Chrome

26)

Google Advanced Search allows specific results by
_______ .

1. A) Domain
2. B) Reading level
3. C) File type
4. D) All of the above

27)



Google Scholar will search blogs, wikis and popular
websites

1. A) True
2. B) False

28)

All images found in a Google image search are
available for reuse.

1. A) True
2. B) False

29)

With a Google Custom Search engine, educators can
specify which sites they want their students to use
when searching.

1. A) True
2. B) False

30)

How can educators create a custom search engine?
1. A) On any topic
2. B) By themselves
3. C) Collaboratively with other educators
4. D) All of the above

31)

Which Google tool allows you to create a spreadsheet?
1. A) Slides
2. B) Hangouts
3. C) Sheets
4. D) Gmail

32)

You can sync a Google calendar on an Android device
and iPhone

1. A) TRUE



2. B) FALSE
33)

With Quickoffice in Google Drive, you can create and
edit Microsoft Office files when you need to make a
quick edit on the go.

1. A) TRUE
2. B) FALSE

34)

Which can be inserted into a Google Slides
presentation?

1. A) Text
2. B) Images
3. C) YouTube Video
4. D) All of the above

35)

A good password contains
1. A) An easily recognizable name
2. B) The word “password”
3. C) Only repeated numbers
4. D) Different letters, numbers, and keyboard characters that are not easily understood

36)

Using Google Drive, the sharing settings are the same
in Docs, Sheets, and Slides

1. A) TRUE
2. B) FALSE

37)

What is the maximum number of search results
retrieved with Google Search

1. A) One million
2. B) 50
3. C) 1001
4. D) There is no maximum

38)



You can share a Google Calendar to the following:
1. A) Privately to your class
2. B) With any individual
3. C) Publicly on the web
4. D) All of the above

39)

With Gmail, you have the option to read and write
emails offline of when you do not have an internet
connection

1. A) TRUE
2. B) FALSE

40)

Which of the following menu options allows you to
save a Google Doc onto your computer

1. A) Download as
2. B) Share to
3. C) Insert to
4. D) Format as

41)

Google Forms can be used to _______.
1. A) build websites
2. B) create surveys
3. C) calculate math equations
4. D) draw pictures

42)

An image can be attached to an email message using
Gmail.

1. A) TRUE
2. B) FALSE

43)

The best use of Google Slides is to create a _____.
1. A) photograph



2. B) video
3. C) dashboard
4. D) presentation

44)

The Chrome omnibox can _____.
1. A) Conduct instant Google searches
2. B) Auto-complete recent web-entries
3. C) Calculate math formulas
4. D) All of the above

45)

What information must be written in the TO field to
send an email?

1. A) Email address of the receiver
2. B) City of the receiver
3. C) Subject of the message
4. D) Phone number of the receiver

46)

The structure of a Google spreadsheet consists of
vertical _____ and horizontal _____.

1. A) columns; rows
2. B) charts; images
3. C) forms; equations
4. D) formulas; links

47)

To grant others access to a Google Doc, you must:
1. A) Copy and paste the URL in an email
2. B) Share the Google Doc in Drive
3. C) Print it
4. D) Do nothing–it is automatically shared to everyone in your address book

48)

In order to share a Google Doc you must have the
following permission:

1. A) Able to edit
2. B) Able to comment



3. C) Able to view
4. D) Able to play

49)

What is the relationship between a form and a
spreadsheet

1. A) A form and a spreadsheet are the same
2. B) The results from a form can be automatically tracked in a spreadsheet
3. C) When printing a spreadsheet, it prints as a form
4. D) A spreadsheet can only be created from a form

50)

In Gmail, what icon is used to signify an attachment to
email?

1. A) A stapler
2. B) A paper clip
3. C) Bird wings
4. D) A book

51)

Once access is granted to a Google Doc, it cannot be
revoked or removed

1. A) TRUE
2. B) FALSE

52)

What is the name of Google’ browser?
1. A) Chrome
2. B) Drive
3. C) Nexus
4. D) Sites

53)

Google Search uses _____ to find the most relevant
documents from the internet.

1. A) Google Maps
2. B) webmaster tools
3. C) algorithms
4. D) spreadsheets



54)

You can receive a Google Calendar meeting invite in
your Gmail inbox

1. A) TRUE
2. B) FALSE

55)

With Google Search you can filter search results by any
of the following categories except _____.

1. A) time
2. B) images
3. C) reading level
4. D) number of downloads

56)

Real-time collaboration in Google Docs means _____.
1. A) multiple people can edit a doc at the same time
2. B) you can only collaborate with people in your time zone
3. C) you should email different versions of the document back and forth
4. D) anyone in the world can automatically view the document

57)

Which of the following programming skills is requied to
edit a Google Site?

1. A) Java
2. B) C++
3. C) Both
4. D) Neither

58)

To successfully access a website, a person types a web
address in a _____.

1. A) typing program
2. B) music application
3. C) navigation bar
4. D) sign-in webpage

59)



Which of the following in NOT a question type in
Google Forms

1. A) Multiple Choice
2. B) Pie chart
3. C) Choose from a list
4. D) Scale

60)

Google Search navigates the web by “crawling”. This
means:

1. A) Phone calling each owner of a website
2. B) Measuring the physical distance from web server to web server
3. C) Following and tracking web links from page-to-page
4. D) Measuring the amount of times a user visits a web page

61)

SMS reminder messages do NOT incur any cost from
Google or your mobile phone operator

1. A) TRUE
2. B) FALSE

62)

Event sharing settings override the settings for the
chosen calendar

1. A) TRUE
2. B) FALSE

63)

Week view must always start on Sunday
1. A) TRUE
2. B) FALSE

64)

In a Google Calendar event invitation, it is possible to
add guests to an existing invite by:

1. A) Publishing the calendar with the event



2. B) Forwarding the event email invitation
3. C) Entering guest email addresses on the event details page
4. D) Select guest names from your calendar list

65)

There is NO limit to how many students you can invite
to a calendar event

1. A) TRUE
2. B) FALSE

66)

When clicking on the Agenda view you will see a:
1. A) printer friendly page with all the events for the week
2. B) list of events with name and start and end times
3. C) checklist with events for the day
4. D) None of the above

67)

You can choose a custom color in Google Calendar if
you don’t like the included ones

1. A) TRUE
2. B) FALSE

68)

Parents of students in your class don’t need to be
Google Calendar or Gmail users to receive and respond
to Google Calendar invitations

1. A) TRUE
2. B) FALSE

69)

You can attach video files that are in Google Drive to
Calendar events

1. A) TRUE
2. B) FALSE

70)



A teacher wants to share her calendar publicly. She can
use which of the following format(s) to share her
calendar?

1. A) XML
2. B) HTML
3. C) ICAL
4. D) All of the above
5. E) None of the above

71)

Once a class calendar has been shared, which of the
following ways can it be accessed?

1. A) Embedded on a class Google Sites page
2. B) As an HTML webpage
3. C) In individual Google Calendar accounts
4. D) All the above

72)

Which features are available while accessing a Google
calendar offline using Offline Google Calendar

1. A) Create a new event
2. B) View event details
3. C) Edit and make changes
4. D) A and B
5. E) B and C

73)

The default calendar view opens up as the _____ view
1. A) Month
2. B) Day
3. C) Week
4. D) List

74)



If you frequently create 15 minute meetings rather than
the default meeting length of one hour, you can make
15 minutes the default length for all your events

1. A) TRUE
2. B) FALSE

75)

It is possible to save a Google Calendar as a pdf file
from the print settings window

1. A) TRUE
2. B) FALSE

76)

Only guests with a Google Apps email account can
receive calendar event invites

1. A) TRUE
2. B) FALSE

77)

If you created a calendar invite, it is possible to view
who else has been invited

1. A) TRUE
2. B) FALSE

78)

If you create an event from the body of a Gmail
message, the event will automatically contain:

1. A) a video call
2. B) an SMS reminder
3. C) a popup reminder
4. D) a hyperlink back to the email for context

79)

It is possible to copy a calender entry from one school
calendar to your own personal calendar



1. A) TRUE
2. B) FALSE

80)

To add another teacher’s calendar to your Other
Calendars list:

1. A) Under you calendar list you click Add, then Add coworker’s calendar, enter their
email address, and click Add

2. B) Type in their email address at the top of the Other Calendars list
3. C) Search for the person using the calendar search box
4. D) A and B
5. E) A and C

81)

It is possible to share a Google calendar with a Google
Group

1. A) TRUE
2. B) FALSE

82)

When you are first invited to an event and you have not
responded to the invitation, the event will appear in
your calendar with a ____ ____

1. A) plus sign
2. B) check mark
3. C) new icon
4. D) question mark

83)

By default, the guest list on a calendar entry is set to be
visible

1. A) TRUE
2. B) FALSE

84)



It is possible to view another person’s calendar from
your school (assuming they have a Google Apps
account)

1. A) TRUE
2. B) FALSE

85)

Once an invited guest receives and responds to an
invite, they cannot change their RSVP

1. A) TRUE
2. B) FALSE

86)

When RSVPing to a Google Calendar event it is
possible to add a note with your RSVP

1. A) TRUE
2. B) FALSE

87)

What appers from the “Find a time” tab on the event
details page?

1. A) List of all the calendars in your calendar list
2. B) Month view of guest and resource calendars
3. C) Email invitation to send to guests
4. D) The busy and available times for all guests and resources

88)

To attach a Google Drive file to a Calendar event,
simply

1. A) click Add Attachment when creating the calendar event
2. B) click Add Attachment on the main Calendar page
3. C) go to Google Drive and share the document with your calendar address
4. D) go to Google Drive, select the file, click More, and click Open With, Calendar

89)



Agenda view is a way to view all your events grouped
by day

1. A) TRUE
2. B) FALSE

90)

To make one of your calendars completely private (not
viewable to anyone besides yourself), which calendar
settings need to be deselected?

1. A) Make this calendar public
2. B) Only share this calendar with everyone at the domain myschool.org
3. C) Hide this calendar from the list
4. D) A and B

91)

You can currrently share your calendar with up to ____
users per day

1. A) 50
2. B) 75
3. C) 100
4. D) 500

92)

Three standard views in your Google Calendar are:
1. A) Day, Week, Month
2. B) Hourly, Daily, Weekly
3. C) Week, Month, Year

93)

It is NOT possible to import calendar data into Google
Calendar

1. A) TRUE
2. B) FALSE

94)



What is one way to create a multi-day calendar event
for a class field trip?

1. A) Select multiple days in the mini calendar on the left side of the main calendar page
2. B) While editing your event details, click the second date box and choose your end

day
3. C) While in ‘week’ or ‘month’ view, right click a day an select the end date from a

drop down menu
4. D) All of the above
5. E) None of the above

95)

Public calendars that are available to add are:
1. A) Sports
2. B) Holidays
3. C) Phases of the Moon
4. D) All of the above
5. E) None of the above

96)

It is possible to customize the frequency of a repeating
event

1. A) TRUE
2. B) FALSE

97)

By default, the Google Calendar shortcut keys will
automatically work when you are in your calendar

1. A) TRUE
2. B) FALSE

98)

When making changes to the event reminders in your
calendar, the changes will apply to you and all invited
guests

1. A) TRUE
2. B) FALSE

99)



You can setup and display more than one custom
calendar view at the same time

1. A) TRUE
2. B) FALSE

100)

When using a Find a Time feature, you can compare up
to ____ calendars

1. A) 5
2. B) 10
3. C) 15
4. D) 20

101)

If students have turned off notifications for new events
they will not receive an email invitation even if you click
Send

1. A) TRUE
2. B) FALSE

102)

Which of the following CANNOT be changed if a
student has the ability to modify an event:

1. A) Event time
2. B) Event location
3. C) Calendar name
4. D) Guest list

103)

To move forward and back a day, week, or month use
the single arrows at the top left of the calendar

1. A) TRUE
2. B) FALSE

104)



When inserting a Google Calendar into a Google site,
which of the following is not an option that can be
customized

1. A) Height/Width
2. B) Border
3. C) View
4. D) Calendar Color
5. E) All of the above can be customized

105)

What is one way to create an event for an after school
club that meets every Tuesday at 2:45pm?

1. A) Include the word “repeat” in the event name
2. B) While editing your event details, check the box Repeat, then select your

preference from the Repeats drop-down menu
3. C) Click the “All Day” event to make the event repeat
4. D) Use the “Find a Time” feature

106)

Events that occur and repeat over several school days
can be setup as one event

1. A) TRUE
2. B) FALSE

107)

Only the event creator can invite guests to calendar
events

1. A) TRUE
2. B) FALSE

108)

It is possible to delete or remove all notifications for all
calendar entries

1. A) TRUE
2. B) FALSE

109)



You can invite students to a single event on a calendar
without sharing the entire calendar

1. A) TRUE
2. B) FALSE

110)

Using the ____ ____ you can quickly customize the
view of your calendar to a few days or weeks at a time

1. A) Display settings
2. B) Default view
3. C) Mini calendar
4. D) Time format

111)

The three options for what guests can do to an event
are:

1. A) modify event, invite others, delete event
2. B) modify event, see guest list
3. C) see guest list, invite others
4. D) modify event, invite others, see guest list

112)

On a mobile device, you can only view your calendar
using a mobile web browser

1. A) TRUE
2. B) FALSE

113)

To create a new, empty calendar which of the following
are the correct steps

1. A) Under the My Calendars list> click Settings> Import calendar
2. B) In the calendar search bar, type “new calendar” and click Create
3. C) Under Settings> Click add> Ener your location and time zone> Click Create
4. D) Under the My Calendars list> click Create new calendar> Enter the calendar

name, description, location, and time zone> Click Create
114)



Another way to add a calendar entry is
1. A) Type the event into Quick Add
2. B) Click on the down-arrow button next to the appropriate calendar in your calendar

list, then click “Create event on this calendar”
3. C) Send an email with the calendar details to

username+newcalendar@myschool.org
4. D) A and B
5. E) A and C

115)

You must have email turned on in Google Apps to use
and share Google Calendars

1. A) TRUE
2. B) FALSE

116)

Using Quick Add it is possible to create recurring
events

1. A) TRUE
2. B) FALSE

117)

You can change the default view of your calendar to
Day, Week, Month, or Agenda

1. A) TRUE
2. B) FALSE

118)

It is NOT possible to publish a Google Calendar as a
webpage

1. A) TRUE
2. B) FALSE

119)



When removing guests from an invite, in order to make
sure the guest list changes take place, you must
remember to click:

1. A) Update
2. B) Save
3. C) Remove
4. D) Restore

120)

What permissions can you set when inviting students
to a calendar event?

1. A) Add the event to their own calendar, edit the guest list, and modify event
2. B) Invite others, edit the guest list, and view the guest list
3. C) Copy the guest list, invite others, modify the event
4. D) Modify event, invite others, and see the guest list

121)

Gmail search doesn’t recognize special search
characters like square brackets, parentheses, currency
symbols, the ampersand, the pound sign, and asterisks

1. A) TRUE
2. B) FALSE

122)

When you remove a contact from a contact group, you
are also removing the contact from your Contacts list

1. A) TRUE
2. B) FALSE

123)

How would you instruct a student to open his/her task
list in Gmail?

1. A) Right click on Inbox and select Tasks
2. B) Click the bottom right ‘list’ button icon
3. C) Click the dropdown arrow next to Mail in the left side of Gmail and select Tasks
4. D) None of the above



124)

Gmail’s auto-show feature automatically selects
contacts to appear in Chat based on the people with
whom you already communicate with most often

1. A) TRUE
2. B) FALSE

125)

Chat in your Gmail inbox recognizes YouTube URLs as
media and automatically converts them to video inside
your chat window

1. A) TRUE
2. B) FALSE

126)

When setting up Mail Fetcher, you have all of the
following options EXCEPT:

1. A) Leave a copy of retrieved messages on the server
2. B) Forward incoming messages
3. C) Always use a secure connection (SSL) when retrieving mail
4. D) Label incoming messages
5. E) Archive incoming messages

127)

Gmail messages that are moved into Trash will remain
there indefinitely until you manually empty your Trash

1. A) TRUE
2. B) FALSE

128)

The basic HTML view in Gmail is a little different from
what you’re used to in Standard view because certain
features aren’t available

1. A) TRUE
2. B) FALSE



129)

A student comes to you stating that she does not have
Internet at home. If she composes a message in
Gmail’s offline mode, clicking send will:

1. A) Move the message to Drafts so you can send it back when you are back online
2. B) Star the message
3. C) Place the message in your Outbox and it will be sent automatically the next time

you connect and sync
4. D) It is not possible to compose messages in Offline mode

130)

If you conducted a search in Gmail and CANNOT find
the message you were looking for, all of the following
are possible explanations EXCEPT:

1. A) The message ended up in Spam
2. B) The message was moved to Trash
3. C) You may have a typo in the search
4. D) The message was archived

131)

In the name of organization, students can use labels to
organize email. Some of the options available to
customize labels in Gmail are:

1. A) Color
2. B) Name
3. C) Visibility in label list
4. D) All of the above

132)

A teacher comes to you unable to access a particular
option or setting. She may be unable to access it
because your school Apps domain administrator may
have disabled that feature

1. A) TRUE
2. B) FALSE

133)



A teacher can send a student an .exe file to install a
program on the student’s Windows computer

1. A) TRUE
2. B) FALSE

134)

To help keep organized, students can use Google Tasks
right from an email. If you would like to create a task
from an email message, you can:

1. A) Go into Tasks and do a search for the email messages
2. B) Go into the email message, click on the More button and select ‘Add to Tasks’
3. C) Drag the email messages to Tasks
4. D) Forward the message to tasks@gmail.com

135)

Chat lets you send and receive instant messages with
teachers, students, other people at your school/district
right in your inbox

1. A) TRUE
2. B) FALSE

136)

Before you can chat with another teacher in Gmail,
unless they appear in the automatic contacts list, you’ll
need to:

1. A) Invite him/her
2. B) Ask him/her to purchase a web cam
3. C) Make sure he/she are using Chrome
4. D) All of the above
5. E) None of the above

137)

How many labels can you apply to an email?
1. A) 1
2. B) 5
3. C) 10



4. D) 15
5. E) Unlimited

138)

Assuming your domain administrator is not overriding
any updates, to enable new features/functionality in
Gmail:

1. A) Follow the directions to download and install updates when notified
2. B) Wait for your domain administrator to give you directions
3. C) Periodically check the Google Apps Update Blog to see if updates are available

for download/install
4. D) Since Gmail is web-based, feature updates will happen automatically

139)

To send a message to any of the contact groups you
created, or the default contact groups you can:

1. A) Send an email message directly from the Contact Manager
2. B) Send an email message to a group from the Compose window using

auto-complete function
3. C) Both of the above
4. D) None of the above

140)

When reviewing your inbox messages, you will notice a
number in parentheses next to the contacts included
on a particular message. The number in the
parentheses corresponds with:

1. A) How many contacts are included in the conversation
2. B) How many times the conversation has been read
3. C) How many messages (or replies) are in the conversation
4. D) How many times the message has been forwarded

141)

When you label one message in the conversation, you
automatically apply the labels to all the messages in
the conversation

1. A) TRUE



2. B) FALSE
142)

By default, Gmail creates all of the following labels
EXCEPT

1. A) Starred
2. B) Chats
3. C) Archived
4. D) Spam
5. E) Drafts

143)

Using Gmail, you can also store more information than
just a name and email address, you can include title,
phone numbers, addresses, instant messenger
accounts, websites, and even birthdays. You can add
custom fields for “Parent’s Names” or “Graduation
Year”

1. A) TRUE
2. B) FALSE

144)

If you are unable to see the ‘Labs’ tab in Settings, you
should:

1. A) Restart your computer
2. B) Contact your domain administrator
3. C) Check your internet connection
4. D) Check that your browser is compatible
5. E) B and D

145)

When you send a Task list to someone else it appears:
1. A) Like a new list in their Tasks
2. B) Just like an email message
3. C) As a pop-up in the bottom right of their window
4. D) You cannot send Tasks with Gmail

146)



You can block contacts from chatting with you, but do
so with caution as this action CANNOT be undone

1. A) TRUE
2. B) FALSE

147)

If you are searching Gmail for a message from Lisa
with a PDF attachment, which of the following
Advanced Search operators would work best?

1. A) from:lisa has:attachment
2. B) message:lisa filename:pdf
3. C) from:lisa has:attachment filename:pdf
4. D) to:lisa has:attachment

148)

Mail delegation in Gmail allows you to delegate access
to your email to another person (e.g. a principal
delegating access to his or her administrative
assistant)

1. A) TRUE
2. B) FALSE

149)

My Contacts in the Contacts window is used to:
1. A) organize all of your contacts
2. B) organize contacts you want to find most often
3. C) organize family and friend contacts
4. D) organize co-worker contacts

150)

To change the background image of your inbox, you
need to click a thumbnail on the ____ tab from ____

1. A) Backgrounds; Inbox
2. B) Backgrounds; Mail Settings
3. C) Themes; Inbox
4. D) Themes; Mail Settings



151)

You can customize your Gmail chat list by doing all of
the following EXCEPT:

1. A) Choose how many contacts you would like to display
2. B) Determine where your chat list appears in the left side of Apps mail
3. C) Decide who will always appear in your chat list
4. D) Order contacts in your chat list
5. E) You can customize all of the above

152)

In Gmail, each task can only be assigned to one list
1. A) TRUE
2. B) FALSE

153)

If you initiate a group chat, the chat will stop for
everyone once you leave the chat

1. A) TRUE
2. B) FALSE

154)

A ____ is an email notification delivered when a
recipient opens an email you send

1. A) responder
2. B) gmail notification
3. C) delivery confirmation
4. D) read receipt

155)

An advantage of inserting files using Drive instead of
attaching a file is:

1. A) People can’t edit the document
2. B) Sending larger files
3. C) People can print the document
4. D) Emails won’t go to the recipient’s Spam folder

156)



Rich text signatures are available in Gmail allowing you
to add your own formatting, images and links to your
email signatures

1. A) TRUE
2. B) FALSE

157)

POP, or Post Office Protocol, lets you ____ from
GoogleApps mail servers onto your computer so you
can access your mail from a 3rd-party program even
when you aren’t connected to the Internet

1. A) upload messages
2. B) download messages
3. C) redirect messages
4. D) delete messages

158)

Teachers and students can categorize email messages
by using ____

1. A) tags
2. B) lists
3. C) keywords
4. D) labels
5. E) All of the above

159)

You will not be allowed to change the name of any of
the default Contact groups in Gmail including: My
Contacts, Friends, Family, Co-workers, and Most
Contacted

1. A) TRUE
2. B) FALSE

160)

The purpose of Gmail Labs is to:



1. A) Give you a sneak peak at what Google Engineers have been up to
2. B) Announce the latest enhancements that are completely vetted and automatically

available for all users
3. C) Give you a place to try the newest features of Gmail that are in the final stages of

development
4. D) A and C

161)

Which of the following is an Inbox type that students
can use in Gmail?

1. A) Priority mail
2. B) Old school
3. C) Fresh view
4. D) Priority inbox

162)

After you set your Gmail’s tab categories on Gmail’s
desktop version, you will also see them on the mobile
versions (Android and iOS)

1. A) TRUE
2. B) FALSE

163)

If you have Chat history enabled, you can do all of the
following with your chats EXCEPT:

1. A) Forward
2. B) Label
3. C) Star
4. D) Trash
5. E) All of the above are possible with Chat history enabled

164)

Students can access a list of Gmail keyboard shortcuts
by typing:

1. A) shift-S
2. B) shift-*
3. C) shift-?
4. D) shift-K
5. E) shift-!



165)

The best way to print an entire email conversation –
including all messages within the conversation – is to:

1. A) Select the File menu from your browser and select Print
2. B) Click the down arrow next to Reply, at the top-right of the message and selet Print
3. C) Open the conversation you want to print and click the Print all button on the right

side of the screen
4. D) Use the keyboard shortcut P

166)

In Gmail, conversations are:
1. A) Individual messages with the same subject line displayed throughout your inbox
2. B) Chat transcripts related to an email message or messages
3. C) A collection of messages with the same subject line
4. D) All of the above
5. E) None of the above

167)

Gmail’s priority Inbox features are the same on the
desktop and on any mobile device

1. A) TRUE
2. B) FALSE

168)

Students can access Gmail offline (with limited
functionality) if the student uses:

1. A) POP
2. B) IMAP
3. C) Offline Google Mail Chrome App
4. D) All of the above

169)

The Tasks calendar in your Google Apps Calendar
allows you to ____ while in your calendar

1. A) Add and edit tasks
2. B) Move tasks
3. C) Switch task lists
4. D) All of the above



170)

With Superstars in Gmail, a user can access up to ____
star icons

1. A) 8
2. B) 10
3. C) 12
4. D) 14

171)

Instead of having one long to-do list, students can
organize tasks into ____

1. A) folders
2. B) labels
3. C) tags
4. D) multiple lists

172)

You must attach files to emails one at a time. Currently,
there is NOT a way to select multiple files at once

1. A) TRUE
2. B) FALSE

173)

Vacation responders in Gmail CANNOT be set up from
your Android or iOS mobile device

1. A) TRUE
2. B) FALSE

174)

The following statements are true about archiving
Gmail messages EXCEPT:

1. A) A message is no longer in your Inbox View
2. B) A message is stored in All Mail for all time
3. C) A message is moved to Trash after not being viewed within 365 days
4. D) A message is available in labels
5. E) A message shows up in search

175)



Ads must be turned on for Gmail in Google Apps for
Education

1. A) TRUE
2. B) FALSE

176)

If not disabled at the domain level, Gmail can forward
all the mail coming into your school Gmail account to
another email address

1. A) TRUE
2. B) FALSE

177)

A student can view all of his/her completed tasks by:
1. A) Use the keyboard shortcut Shift + T
2. B) Go to ‘Actions’ and select ‘Clear completed’
3. C) Right click on the task and select ‘View completed Tasks’
4. D) Go to the ‘Actions’ menu and select ‘View completed Tasks’

178)

Gmail provides a chat feature
1. A) TRUE
2. B) FALSE

179)

Gmail’s new inbox groups your mail into categories
which appear as different tabs. Besides ‘Primary’,
which other tabs can you enable?

1. A) Important, Social, Promotions, Forums
2. B) Starred, Social, Updates, Forums
3. C) Social, Promotions, Updates, Forums
4. D) Spam, Starred, Priority, Sent

180)

To view archived messages in Gmail, go to:
1. A) Archived Mail



2. B) All Mail
3. C) Old Mail
4. D) Trash

181)

The proper way to send a Google document for
colleagues to see or edit is to email an attachment or
upload a file for others to access

1. A) TRUE
2. B) FALSE

182)

All of the following are key compatibility advantages of
Google Drive, except:

1. A) No need to install upgrades
2. B) Works with most modern web browsers
3. C) Ability to convert Wordperfect files into Google documents
4. D) One file can be shared, viewed & edited by many users

183)

Google Drive can be accessed at a custom URL for
your school. This needs to be set by a domain
administrator

1. A) TRUE
2. B) FALSE

184)

When you share a document with a group email alias (a
Google Apps group), they will need to first open the
document before it will appear in their Drive

1. A) TRUE
2. B) FALSE

185)



Google Apps for Education has a template gallery
within your school Apps domain that is separate from
the public gallery

1. A) TRUE
2. B) FALSE

186)

The Research tool within documents allows you to
choose from which of the following citation methods?

1. A) MLA, APA, Chicago
2. B) APA, Chicago
3. C) MLA, APA
4. D) APA, Chicago

187)

Select ____ to combine all selected cells in a range into
one cell

1. A) Merge all
2. B) Merge cells horizontally
3. C) Merge cells vertically
4. D) None of the above

188)

Mr. Rodriguez is a physics teacher. He has a document
he’s shared with other teachers in his school. One
teacher retires, how can he remove the retired teacher
from a shared document?

1. A) Move the document to a new folder
2. B) Change the visibility option of the document
3. C) Remove the collaborators one at a time form the Share settings
4. D) All of the above
5. E) Both B and C

189)



The following can be inserted into a document via the
Insert menu:

1. A) Bookmark
2. B) Table of contents
3. C) Dictionary
4. D) A and B

190)

A ____ allows you to interpret data in dynamic ways
without entering formulas

1. A) script
2. B) live view
3. C) dynamic view
4. D) pivot table

191)

Once a comment has been resolved in Google Docs, it
can no longer be viewed or edited

1. A) TRUE
2. B) FALSE

192)

Bookmarks are highlighted sections with comments in
a document

1. A) TRUE
2. B) FALSE

193)

Forms allow teachers to set the frequency of
notifications for form responses. Which of the following
is NOT an option?

1. A) Daily digest
2. B) Weekly digest
3. C) Immediately (Right Away)
4. D) All of the above are options

194)



If you are creating a form with your Google Apps for
Education account, you can also choose to record the
email addresses of members of your Apps domain that
fill out your form.

1. A) TRUE
2. B) FALSE

195)

Students can send an email to the collaborators on a
document (presumably other students) by going to:

1. A) Tools > Preferences
2. B) File > Email as attachment
3. C) File > Email Collaborators
4. D) Publish > Email collaborators

196)

____ adds visual page breaks while you’re editing
documents, so you can see how many pages of that
report you’ve actually finished

1. A) Tabbed breaks
2. B) Pagination
3. C) Compact view
4. D) Polyline

197)

The ____ of a document, spreadsheet, presentation, or
drawing can always control exactly who has access to
their document and how much access each person has

1. A) editor
2. B) owner
3. C) viewer
4. D) A and B
5. E) B and C

198)



If three teachers are editing a document
simultaneously, they will need to wait a few minutes to
see each others’ edits

1. A) TRUE
2. B) FALSE

199)

The paste special option gives you more control about
what properties you’re copying and pasting into a
range of cells. Which of the following is not an option?

1. A) Paste formula only
2. B) Paste values only
3. C) Paste data validation only
4. D) Paste functions only

200)

In Docs, using the Research tool, to cite a web source
you

1. A) highlight the text to be cited, hover over the result and click Cite
2. B) highlight the text to be cited, drag the web link to the text
3. C) highlight the text to be cited, click Insert Link
4. D) All of the above will work
5. E) None of the above will work

201)

In order to remove a sheet from view in a spreadsheets
workbook, you have to click on a sheet tab and select
____

1. A) “Cloak sheet”
2. B) “Mask sheet”
3. C) “Hide sheet”
4. D) “Remove sheet”

202)



____ rows and columns allows you to keep some of
your data in the same place while you scroll through
the rest of your spreadsheet

1. A) Sorting
2. B) Cementing
3. C) Freezing
4. D) Icing

203)

Google Sheets can be exported to the following
formats

1. A) .xls
2. B) .rtf
3. C) .csv
4. D) A and B
5. E) A and C

204)

Formatting rules in spreadsheets allow you to change
the color of text or background of a cell based upon a
value

1. A) TRUE
2. B) FALSE

205)

When uploading a folder with subfolders into Google
Drive, the subfolder structure will be maintained

1. A) TRUE
2. B) FALSE

206)

Once an animation is listed in the Animations pane,
you can drag an animation up or down to change the
order in which shapes appear or disappear on the
screen



1. A) TRUE
2. B) FALSE

207)

If a student embeds his/her Google Slides presentation
into a web page, s/he can use all of the following
advanced features, EXCEPT:

1. A) Autoplay
2. B) Audio voiceover
3. C) Timing between slides
4. D) Automatically restart the presentation (loop)

208)

In Docs, when adding a picture from the Research tool,
a citation is added

1. A) as a footnote
2. B) on a reference page
3. C) on a bibliography page
4. D) citations are not added automatically

209)

Google Docs allows users to work on the same
document, at the same time

1. A) TRUE
2. B) FALSE

210)

Which of the following is NOT a slide layout option in
Google Slides?

1. A) Title
2. B) Blank
3. C) Caption
4. D) Three columns

211)

____ in spreadsheets are a helpful way to leave notes
to other collaborators about your spreadsheet data



1. A) Tasks
2. B) Footnotes
3. C) Messages
4. D) Comments

212)

In the Sheets revision history, changes are not
color-coded based on each collaborator, but students
can still tell what has been added or deleted

1. A) TRUE
2. B) FALSE

213)

You are able to share docs from your mobile device
1. A) TRUE
2. B) FALSE

214)

A student is working on a Google Slides presentation.
She wants to embed a video from Vimeo, and simply
needs to copy and paste the embed code Vimeo
provides into her presentation slide

1. A) TRUE
2. B) FALSE

215)

Using the Research tool, an easy way to get pictures
into your document is to simply

1. A) hover over the picture and click Insert
2. B) click on the picture and click Insert
3. C) click and drag the picture into the document
4. D) right click to download the image and then upload it into the document

216)

Google Drawings allows teachers to import the
following file formats

1. A) .PNG



2. B) .SVG
3. C) .JPG
4. D) All of the above
5. E) None of the above

217)

____ can set editing permissions for individual sheets
in Google Sheets

1. A) Document owners
2. B) Document owners and editors
3. C) Anyone with editing rights
4. D) Anyone with access to the spreadsheet

218)

You must install the Google Drive app in Chrome before
you can use Offline Docs

1. A) TRUE
2. B) FALSE

219)

Students can currently modify the layout of their form
through a number of methods, EXCEPT for the
following

1. A) Rearrange questions
2. B) Adding section headers
3. C) Creating your own theme
4. D) Selecting a designed theme

220)

Sharing level access changes usually take about an
hour to take effect

1. A) TRUE
2. B) FALSE

221)



To see who has edit or view access to your document
at any time, simply click the ____ button in the top right
corner of the doc

1. A) Tools
2. B) View
3. C) Share
4. D) Publish

222)

You can print your Google documents and
spreadsheets from your mobile device using Google
Cloud Print

1. A) TRUE
2. B) FALSE

223)

Ms. Blake had students respond to a survey using
Forms. She wants to see the data by specific users.
She can edit the summary of responses to exclude
certain users

1. A) TRUE
2. B) FALSE

224)

If you add documents to a shared folder, the document
is automatically shared with everyone who has access
to the shared collection

1. A) TRUE
2. B) FALSE

225)

Which of the following is NOT a question type in
Forms?

1. A) Scale



2. B) Divergent
3. C) Checkboxes
4. D) Choose from a list

226)

Which of the following is NOT a source built into the
Research tool?

1. A) Images
2. B) Scholar
3. C) Blogger
4. D) Quotes

227)

To view your presentation with no browser toolbars as
a distraction, which icon should be selected?

1. A) Options
2. B) Play
3. C) Full screen
4. D) None of the above

228)

When you create a master presentation with a theme,
even a blank theme, any imported slides can be
adapted to that theme

1. A) TRUE
2. B) FALSE

229)

To save a copy of a presentation to our computer, you
can download it as a file. Which of the following is not a
file option?

1. A) TXT
2. B) PDF
3. C) GIF
4. D) PNG
5. E) PPTX

230)



To allow student responders to see the summary of
responses to a form, the teacher needs to check which
button?

1. A) Show link to submit another response
2. B) Publish and show a link to the results of this form to all respondents
3. C) Allow responders to edit responses after submitting
4. D) Show progress bar at bottom of form pages

231)

Users have the ability to export Google docs to a PDF
1. A) TRUE
2. B) FALSE

232)

To view a comment after it’s been inserted into a
spreadsheet cell, ____ your mouse over the orange
comment indicator

1. A) drag
2. B) hover
3. C) right-click
4. D) double-click

233)

The ____ feature in Google Sheets makes it easier to
analyze and view your data by hiding the data that you
temporarily want to take out of view

1. A) sort
2. B) lookup
3. C) organize
4. D) filter

234)

It is possible to upload images directly to a
spreadsheet in Google Sheets

1. A) TRUE
2. B) FALSE



235)

When you publish a document and view it as a web
page, the comments will NOT be viewable on the web
page

1. A) TRUE
2. B) FALSE

236)

Mrs. Pringle is a French language teacher. She wants to
translate text in a Google Spreadsheet. Which function
would she use?

1. A) =GoogleLookup
2. B) =GoogleTranslate
3. C) =GoogleLanguage
4. D) =GoogleTournament

237)

Google Drive allows you to save any document,
spreadsheet, presentation, drawing, or form as a
template for others to use

1. A) TRUE
2. B) FALSE

238)

How many users may edit and view a spreadsheet,
document, or drawing at the same time?

1. A) 25
2. B) 50
3. C) 75
4. D) 100

239)

Data validation in spreadsheet allows teachers to do all
of the following EXCEPT:

1. A) Validate formulas



2. B) Validate number, dates, and text
3. C) Prevent users from entering text that doesn’t match your criteria, or show them a

comment on the cell when the data doesn’t match the validation rule
4. D) Add text to the cells that have data validation which helps your collaborators enter

the right type of data
240)

Which of the following is NOT a data type that can be
entered into a spreadsheet cell?

1. A) Time
2. B) Dates
3. C) Kcals
4. D) Currencies
5. E) Percentages

241)

A file cabinet allows you to ____ lessons and ____
resource documents on your site

1. A) Sync, organize
2. B) Upload, manage
3. C) Download, edit
4. D) Edit, replace

242)

It is possible to reorganize the pages added to the
sidebar navigation

1. A) TRUE
2. B) FALSE

243)

It is possible to access Google Sites by a custom URL
for your school

1. A) TRUE
2. B) FALSE

244)



One way to interact with viewers of your Google Site is
to embed Google Moderator. All of the following are
benefits of Google Moderator except:

1. A) An online interactive Q & A
2. B) Participants can submit and vote at different times
3. C) Submitting and voting via text messaging
4. D) The owner of the Moderator page can set a deadline for submitting and voting

245)

The announcement page behaves most like a:
1. A) Webpage
2. B) Blog
3. C) List
4. D) Portal

246)

Which of the following is not one of the main elements
of a site layout in Google Sites?

1. A) Header
2. B) Menus
3. C) Footer
4. D) Page Content

247)

Sites you have created in Gmail account or non Google
Apps account will show up by default in your Google
Sites list for your school if you created them using the
same computer

1. A) TRUE
2. B) FALSE

248)

If you gave a group of students edit access to a site,
they would be able to remove other attachments and
comments that are not their own



1. A) TRUE
2. B) FALSE

249)

When creating a hyperlink on a Google Sites page there
are three link options in the Create Link window that
pops up. Which of the answers below is not an option?

1. A) Sites page
2. B) Navigation bar
3. C) Web address
4. D) Apps Script

250)

When using a list page type, you must choose from
preset list properties and cannot create a customized
list

1. A) TRUE
2. B) FALSE

251)

Students can embed a form into a page in Google Sites
1. A) TRUE
2. B) FALSE

252)

Of the following, which is NOT editable in the “Edit Site
Layout” view?

1. A) Site width
2. B) Horizontal Navigation
3. C) Themes, colors and fonts
4. D) System footer

253)

It is possible to format where the embedded gadgets
appear on the page by editing the alignment,
properties, and wrapping of a gadget

1. A) TRUE



2. B) FALSE
254)

To change the default logo in the header of your site,
you can

1. A) Upload an image from your computer
2. B) Paste an image in the header
3. C) Link to an image on the web
4. D) All of the above
5. E) None of the above

255)

Google Sites can automatically maintain your site
navigation

1. A) TRUE
2. B) FALSE

256)

You can only select a custom color for your site theme
attributes using a hex value (like #FFFFFF)

1. A) TRUE
2. B) FALSE

257)

A custom ____ lets you save the layout and content of
a webpage to use for future pages in your site

1. A) Page template
2. B) Page theme
3. C) Page setting
4. D) Page preference

258)

Placing gadgets into your Google site is done from the
____ menu while editing your site

1. A) Format
2. B) Insert
3. C) Gadget
4. D) Layout



259)

One of your students deletes a page. It is possible to
recover it using the site revision history

1. A) TRUE
2. B) FALSE

260)

The default logo for your site in Google Sites is the
logo selected in your Google Apps for Education
control panel

1. A) TRUE
2. B) FALSE

261)

Using a table of contents can help visitors to your site
jump to sections on your page that are interesting or
relevant

1. A) TRUE
2. B) FALSE

262)

It is possible to share only some pages within a site
with student accounts in your domain

1. A) TRUE
2. B) FALSE

263)

Which of the following can be done using a Google
site:

1. A) Personalize site theme, background, colors and logos
2. B) Add navigation menus and sitemaps
3. C) Let collaborators add files or comments to pages
4. D) All of the above
5. E) None of the above

264)



Regardless of domain administrator settings, a student
can decide if their site will be published publicly

1. A) TRUE
2. B) FALSE

265)

There are different types of layouts for standard
webpages. All of the following are page layouts for
standard pages in Google Sites except:

1. A) Two column (simple)
2. B) One column (with header and footer)
3. C) Bottom navigation (with header and footer)
4. D) Right sidebar (with header and footer)

266)

When creating a new site, it is possible to use a
template from the template gallery or begin with a blank
template

1. A) TRUE
2. B) FALSE

267)

You can configure the search box in Google Sites to
use a Custom Search Engine or search specific sites

1. A) TRUE
2. B) FALSE

268)

Which of the following are all the sharing options for
Google Sites

1. A) Viewers and Editors
2. B) Viewers and Owners
3. C) Viewers and Collaborators
4. D) Viewers, Editors, and Owners

269)



Once activated, page-level permissions CANNOT be
turned off

1. A) TRUE
2. B) FALSE

270)

The username of a Google Apps user cannot be
collected when submitting a Google Form embedded
on a site

1. A) TRUE
2. B) FALSE

271)

Inserting an image includes several options except:
1. A) Alignment of image on the page
2. B) Size of image on the page
3. C) Wrap text around the image
4. D) All the above are options

272)

____ permissions allow you to set different levels of
access for different people on different pages

1. A) Site-level
2. B) Page-level
3. C) Sharing
4. D) Page

273)

The Google Sites gadget director contains a variety of
gadget categories including News, Finance, and Public

1. A) TRUE
2. B) FALSE

274)

To change your Google Site name or categories:
1. A) Go to the More button and Select Change site name



2. B) Go to the Edit Page button and select Change site name
3. C) Go to the More button, click Manage site and select General Settings
4. D) Double click the site name at the top of the page

275)

After embedding a Google Doc into your classroom
Google Site, it is necessary to edit the site again in
order for new changes in the document to appear on
the site

1. A) TRUE
2. B) FALSE

276)

You cannot use embed codes to insert objects into
Google Sites

1. A) TRUE
2. B) FALSE

277)

With page-level permissions, you could allow all your
students to see one set of pages, allow your
co-workers to edit another set of pages, and then keep
yet another set of pages private only to yourself

1. A) TRUE
2. B) FALSE

278)

Options to notify students, faculty and staff of updates
and changes to your Google Sites include RSS feeds,
recent announcements, and email notifications

1. A) TRUE
2. B) FALSE

279)



When sharing a site with the world all of the following
are true except:

1. A) Your domain administrator must allow it in the domain settings
2. B) Parents or guardians of students with domain accounts must log in to view the site
3. C) All elements of your page that have sharing permissions must also be available to

the public, including any docs, calendars, etc.
4. D) The visibility settings for the site must be set to Public to the Web

280)

Which of the following is not a change you can make in
your page settings:

1. A) Show/hide page titles
2. B) Allow attachments or comments
3. C) Show links to sub-pages
4. D) Show revision history dates

281)

When customizing the search tool for Google Sites, the
search option settings include:

1. A) Allow to search at google.com
2. B) Allow to search only at this site
3. C) Allow to search at all the sites at myschool.org
4. D) All the above

282)

Below are different page types you can create in
Google Sites except:

1. A) Photo page
2. B) File cabinet page
3. C) Start page
4. D) List page

283)

An easy way to support students using Google Sites
for their course is to create a ____ which they can copy
to create their Sites pages



1. A) handout
2. B) webpage
3. C) template
4. D) sample

284)

Page layouts can only be applied to the ‘web page’
type, not the ‘list’, ‘announcement’ or ‘file cabinet’ page
types

1. A) TRUE
2. B) FALSE

285)

It is not possible to change your Google Sites theme
once the site has been created

1. A) TRUE
2. B) FALSE

286)

Select the correct sequence: To make color and font
changes to areas in your Google site select from the
top right of the Google site page:

1. A) Edit page > Colors and fonts
2. B) More > Manage site > Site layout
3. C) Edit page > Manage site > Themes
4. D) More > Manage site > Colors and fonts

287)

It is possible to add sub-menu navigation links to the
sidebar

1. A) TRUE
2. B) FALSE

288)

When copying a previous site to a new site, you will be
prompted to:

1. A) Create a new site and site name



2. B) Create the URL and the sub pages
3. C) Type in a site name and the URL
4. D) Type in a site name and edit the page

289)

Collaborators on a Google Site can do all of the
following except:

1. A) Add/remove pages to the sidebar navigation
2. B) Change the site theme
3. C) Delete pages
4. D) Move pages

290)

With whom can you share your site (and set
permissions)?

1. A) Individuals
2. B) With a group
3. C) With the entire school
4. D) With the public
5. E) All the above

291)

Only Apps domain super administrators have
automatic access to all the created Google Sites in an
apps domain and have the rights to delete and edit
sites all sites within that domain

1. A) TRUE
2. B) FALSE

292)

When creating a site, you must be careful of the URL
you choose as this is a setting you will not be able to
change later, though you may be able to change the
‘root’ URL’ with web address mapping

1. A) TRUE
2. B) FALSE

293)



If you grant access to a site/page to a Google Group:
1. A) everyone in that group has access
2. B) you still need to individually invite everyone in the group
3. C) A and B
4. D) none of the above

294)

By default, Google Sites include a search box for
individual sites

1. A) TRUE
2. B) FALSE

295)

With the ____, you can add HTML, CSS and Javascript
into a Google Sites page

1. A) HTML widget
2. B) HTML Box tool
3. C) CSS widget
4. D) Custom Dev tool
5. E) None of the above

296)

When using Google sites on your domain the maximum
attachment size is ____ and the number of pages per
site is ____

1. A) 100Mb, 100
2. B) 100Mb, 50
3. C) unlimited, unlimited
4. D) 20Mb, unlimited

297)

If a teacher deletes their Google Site, it is not possible
to recover it

1. A) TRUE
2. B) FALSE

298)



A Google site can have multiple authors so that you
and your students can make changes to it

1. A) TRUE
2. B) FALSE

299)

It is possible to embed your course Google Calendar
into your Google Site

1. A) TRUE
2. B) FALSE

300)

If you would like to add a horizontal navigation bar to
your site go to Site layout > Change site layout and
click on the Horizontal navigation bar

1. A) TRUE
2. B) FALSE

301)

Google Chrome has security features that are
particularly useful in the classroom and for students.
These features include ____

1. A) sandboxing
2. B) safe browsing
3. C) auto-updates
4. D) All of the above

302)

To help students not accidentally close a tab they’re
working in, Mr. Rodriguez has them “pin” the tab in
Chrome. By pinning the tab, this

1. A) makes the tab accessible on the desktop
2. B) creates a bookmark to the tab’s website
3. C) locks the tab to the browser window and takes away the x to close the tab
4. D) locks the tab to the new tab window



303)

A good way to browse the web privately in Google
Chrome is to

1. A) turn on private browsing
2. B) use an alias
3. C) go into incognito mode
4. D) None of the above are effective privacy measures

304)

The Languages settings provide the option to translate
webpages using

1. A) Google Translate
2. B) an in-person translation service
3. C) a tool to auto-find a similar page in another language
4. D) None of the above

305)

When setting Startup pages in Google Chrome, users
can choose to set the homepage to

1. A) open the new tab page
2. B) continue where I left off
3. C) open a specific page or set of pages
4. D) All of the above

306)

Extensions are organized and searchable in the
Chrome Web Store just like apps

1. A) TRUE
2. B) FALSE

307)

Google Chrome extensions are
1. A) new versions of browser in development mode
2. B) modifications of the browser to run on Chromebooks
3. C) small programs that add new features to your browser
4. D) chrome features only available on Android devices

308)



Custom themes for the Google Chrome browser can be
added from

1. A) the new tab page
2. B) Google Images
3. C) the Chrome Web Store
4. D) any website

309)

Which of the following Google Chrome tools would be
helpful when teaching a web development class?

1. A) Incognito mode
2. B) Downloads
3. C) View Source
4. D) New tab window

310)

The default viewing window for new tabs in Google
Chrome include all of the following EXCEPT

1. A) thumbnails of the most visited sites
2. B) bookmarks
3. C) Google Chrome settings
4. D) the apps menu

311)

When a student chooses to “Clear all” on the Google
Chrome Downloads page, the downloads are removed
from the Google Chrome list but remain in the
download folder location on the local device

1. A) TRUE
2. B) FALSE

312)

The Chrome Web Store includes all of the following
tools for installation EXCEPT

1. A) Apps
2. B) Themes



3. C) Applets
4. D) Extensions

313)

If enabled, Google Cloud Print allows teachers to
1. A) print to any Internet connected printer
2. B) print only to wireless printers
3. C) print from a mobile device
4. D) A and C

314)

When printing from Google Chrome, teachers have all
of the following options for output EXCEPT:

1. A) Page layout
2. B) Two sided printing
3. C) Number of copies
4. D) Collating

315)

A wide range of apps, extensions, and themes can be
found in the

1. A) Google Apps Marketplace
2. B) Training Center
3. C) Help Center
4. D) Chrome Web Store

316)

With Chrome for Education, you can deploy a private
web store with custom and curated apps

1. A) TRUE
2. B) FALSE

317)

The History option in the Google Chrome menu will
provide all of the following features EXCEPT:

1. A) A detailed browsing history
2. B) A search feature for looking through the web history
3. C) Browsing history across multiplied devices when users are signed into Google

Chrome



4. D) The option to sign out of other devices
318)

The Chrome Web Store is available on Firefox as well
1. A) TRUE
2. B) FALSE

319)

Where would a user find the collection of installed
Google Chrome apps?

1. A) In the system tray
2. B) On the Apps page from the New Tab page in Chrome
3. C) In the Apps Launcher
4. D) Both B and C

320)

The Zoom option in the Google Chrome menu allows
teachers to do all of the following EXCEPT:

1. A) Zoom in
2. B) Zoom out
3. C) View full screen browser
4. D) Change the display settings

321)

Where would a teacher go to add additional Google
Chrome users with separate account credentials?

1. A) Chrome menu > Advanced
2. B) Chrome menu > Settings > Users section
3. C) Chrome menu > Tools > Users
4. D) Chrome menu > Help > Users

322)

The Appearance option on the Settings page allows for
all of the following customizations EXCEPT

1. A) Get themes
2. B) Show home button
3. C) Add additional toolbars to the browser
4. D) Always show the bookmarks bar

323)



Which of the following is NOT a option when clearing
browsing data in Google Chrome?

1. A) Delete the browser from your computer
2. B) Empty the cache
3. C) Clear download history
4. D) Clear data from hosted apps

324)

If a student using the “Custom Passphrase Encryption”
for Advanced Sync Options forgets the passphrase, all
synced data will need to be deleted and reset

1. A) TRUE
2. B) FALSE

325)

When clearing browsing data in Google Chrome,
teachers are presented with multiple time ranges to
remove including selections since “the beginning of
time”

1. A) TRUE
2. B) FALSE

326)

With Chrome, students can sign in to their browser
1. A) at home
2. B) at school
3. C) from a tablet or mobile phone
4. D) All of the above

327)

If a student chooses to sign in to Google Chrome,
where can that student access all of his/her Google
Chrome information?

1. A) On that device only



2. B) On up to two devices that the user has previously logged in to
3. C) On any device that the student is signed into
4. D) None of the above

328)

When students browse in incognito mode, Google
Chrome will store which of the following components in
the web history:

1. A) Web addresses
2. B) Downloaded files
3. C) Cookies
4. D) None of the web components above will be stored in the web history while in

incognito mode
329)

There is an option in Google Chrome to save entire
webpages to an external storage location

1. A) TRUE
2. B) FALSE

330)

There is a category of Chrome Apps in the Chrome Web
Store entitled “Education” that has lots of tools useful
in the classroom

1. A) TRUE
2. B) FALSE

331)

Google provides many resources for teachers and
students to get additional help for Google Chrome
users including

1. A) a Google Chrome YouTube Channel
2. B) an official Google Chrome blog
3. C) the Google Chrome help site
4. D) All of the above

332)



To check the version and status of Google Chrome, a
student can navigate to which of the following menu
options?

1. A) Help
2. B) About Google Chrome
3. C) Edit
4. D) Find

333)

Chrome for mobile allows users to sign in and to sync
bookmarks AND history

1. A) TRUE
2. B) FALSE

334)

To turn on auto-updates in Google Chrome, a teacher
must

1. A) check the option on the Settings page
2. B) click the updates icon on the toolbar
3. C) click the updates icon on the new tab page
4. D) Auto-updates do not require any action by the user

335)

When creating an application shortcut from Google
Chrome, which of the following is not a destination
option for the shortcut?

1. A) Bookmark bar
2. B) Desktop
3. C) Start menu
4. D) Taskbar

336)

The Recent tabs menu option in Google Chrome will
show teachers a list of recent tabs to revisit AND will
show recent tabs from multiple devices that a user is



logged into Google Chrome on for anytime, anywhere
access

1. A) TRUE
2. B) FALSE

337)

Google Chrome is NOT available for which of the
following operating systems

1. A) Windows Phone
2. B) Android
3. C) iOS
4. D) Linux

338)

The Chrome app overview window will give all of
following details EXCEPT:

1. A) app reviews
2. B) related apps
3. C) multiple browser instructions
4. D) number of users

339)

Autofill is a time saving feature in Google Chrome that
allows users to store

1. A) phone numbers
2. B) addresses
3. C) Both A and B
4. D) None of the above

340)

The most efficient way for students to move an existing
tab in Google Chrome to a new window is to

1. A) copy the web address, close the tab, open a new window, and paste the web
address

2. B) drag and drop the tab out of the existing window to open a new window
3. C) pin the tab
4. D) add the site to bookmarks

341)



With Safe Browsing technology enabled in Google
Chrome, if users encounter a website suspected of
containing phishing or malware on the web, the user
will be directed to restart the browser

1. A) TRUE
2. B) FALSE

342)

In Google Chrome, tabbed browsing allows students to
open multiple websites in multiple browsing windows
along the bottom of the screen

1. A) TRUE
2. B) FALSE

343)

To rearrange existing tabs in a window, a student can
1. A) right click on the tab and reload
2. B) drag and drop the tabs in any order at the top of the browser
3. C) unpin tabs
4. D) right click and choose sort

344)

When a student closes a window in Google Chrome,
what components are closed?

1. A) The current tab
2. B) The current window and all open tabs in that window
3. C) All open Google Chrome windows
4. D) The Google Chrome menu closes

345)

In Google Chrome, students are able to set multiple
homepages to open at startup for quick access to the
important classroom pages

1. A) TRUE
2. B) FALSE



346)

To create a bookmark in Google Chrome students can
do all of the following EXCEPT:

1. A) select the star in the address bar of the browser
2. B) use the keyboard shortcut Ctrl+D (Mac: CMD-D)
3. C) go to the Google Chrome menu, select Bookmarks, and choose to Bookmark this

page
4. D) use the keyboard shortcut Ctrl+B (Mac: CMD-B)

347)

To close non-responsive processes or tabs in Google
Chrome, a student can use

1. A) the bookmarks bar
2. B) the task manager
3. C) the Chrome Web Store
4. D) Incognito mode

348)

Which of the following is NOT included as an option in
Advanced Sync settings?

1. A) Toolbars
2. B) Autofill
3. C) Passwords
4. D) Settings

349)

The Google Chrome History window will allow students
to

1. A) search web browsing history
2. B) clear all browsing data
3. C) see the times that webpages were visited
4. D) All of the above

350)



The “Bookmark Open Pages” options in Google
Chrome menu will save and store all open webpages
into a new bookmark folder

1. A) TRUE
2. B) FALSE

351)

This special type of app allows for direct access to and
from Google Drive

1. A) Doc app
2. B) Drive app
3. C) Any program from the Apps Marketplace
4. D) Themes

352)

Using incognito mode allows students to bypass
school or district filtering

1. A) TRUE
2. B) FALSE

353)

The Web content feature can be particularly helpful in
the classroom because it

1. A) allows teachers to filter websites
2. B) allows fonts to be customized for students to meet individual learning needs
3. C) keeps browsing within the school intranet
4. D) allows Java to run on a Chromebook

354)

The main difference between Google Chrome apps and
extensions is

1. A) how to find them
2. B) that you install apps, but not extensions
3. C) that extensions can be used on most websites, apps typically are standalone tools
4. D) None of the above

355)



Google Chrome allows users to make any search
engine the default for omnibox searches

1. A) TRUE
2. B) FALSE

356)

When signed into Google Chrome, which of the
following components will be accessible across
devices with Advanced Sync?

1. A) Apps
2. B) Extensions
3. C) Bookmarks
4. D) All of the above

357)

A teacher is wary of installing extensions, and wants to
see reviews of the extension before she installs it. The
most efficient way that she can find a list of reviews for
a particular extension is

1. A) on the front page of the Chrome Web Store
2. B) by performing a Google Search
3. C) on the extension overview pop up from the Chrome Web Store
4. D) in the Play Store

358)

A Theme is
1. A) a way to customize the daily doodle on the Google homepage
2. B) an overlay for Google Drive
3. C) a visual sorting feature available for Google Drive, but only in Google Chrome
4. D) custom look and feel options for the Google Chrome browser that can be found in

the Chrome Web Store
359)

Users of Google Chrome can add a custom overlay to
enhance the look and feel of the browser with

1. A) gifts



2. B) themes
3. C) views
4. D) icons

360)

Teachers can check the Google Chrome browser
update process at

1. A) the Google Chrome homepage
2. B) the Chrome Web Store
3. C) Google Chrome updates occur automatically in the background processes
4. D) None of the above

361)

In spreadsheets, it is possible to chart multiple ranges
of data

1. A) TRUE
2. B) FALSE

362)

____ lets you convert images with text into text
documents using automated computer algorithms

1. A) Optional Computer Reformatting (OCR)
2. B) Optical Character Recognition (OCR)
3. C) Portable Document Format (PDF)
4. D) Conversion Adaptability Blueprint (CAB)

363)

____ allows you to align objects with the drawings
canvas and other objects

1. A) Object alignment
2. B) Snap to grid
3. C) Align to guides
4. D) Snap to guides

364)



When members are removed from a Google Apps
Group, their access to a document shared to the group
will NOT change

1. A) TRUE
2. B) FALSE

365)

Students can do all of the following working together in
groups in Google Docs EXCEPT

1. A) In-document chat
2. B) Video chat within the document
3. C) Real-time document collaboration
4. D) Share the document with a group

366)

Both the owner and editors of a document can delete
the document

1. A) TRUE
2. B) FALSE

367)

When uploading an image from your computer into
Drawings, what is the maximum file size?

1. A) 1 MB
2. B) 2 MB
3. C) 5 MB
4. D) 10 MB

368)

If a student collaborator duplicates a protected sheet,
copies the workbook, or uploads a new version, sheet
protection settings will remain intact on the new copies
of the document

1. A) TRUE
2. B) FALSE



369)

You must allow offline access for each individual
computer where you’d like to view your documents and
spreadsheets without an Internet connection

1. A) TRUE
2. B) FALSE

370)

How many students can you have respond to a Google
Form? In other words, what is the limit for individual
responses to a form?

1. A) 50
2. B) 500
3. C) 5000
4. D) No limit

371)

When students create a new presentation slide, there is
only one choice for a slide layout

1. A) TRUE
2. B) FALSE

372)

To add a document to a folder from your docs list, you
can do the following

1. A) Drag the doc from your docs list to the folder
2. B) Email the doc to the shared collection’s unique address
3. C) Select the doc > click the More menu > click Move to ··· > select the desired folder
4. D) A and B
5. E) A and C

373)

In Drive, people who can edit your document will also
be able to share it with additional people unless you
change the default settings



1. A) TRUE
2. B) FALSE

374)

Which of the following is not a notification that can be
set on a spreadsheet?

1. A) When changes are made to forms
2. B) When the spreadsheet is duplicated
3. C) When collaborators are added or removed
4. D) When changes are made to a specific sheet

375)

Animations can be used to control the sequence in
which objects appear on a slide in Google Slides

1. A) TRUE
2. B) FALSE

376)

Which of the following is NOT saved in a document
1. A) Edits
2. B) Chats
3. C) Comments
4. D) None of the above

377)

Unlike Docs, Sheets, and Slides, it is NOT possible to
have multiple editors in a Drawing in Google Drive

1. A) TRUE
2. B) FALSE

378)

There are three ways to use text in Google Drawings.
Which of the following is not one of those ways?

1. A) Add text within shapes
2. B) Add word art
3. C) Insert text boxes
4. D) Add text using speech-to-text

379)



Students can print the following document types from
Google Drive

1. A) Drawings
2. B) Documents
3. C) Spreadsheets
4. D) Presentations
5. E) All of the above

380)

A student comes to you having deleted 6 of his 12
slides in a presentation. Unfortunately, those slides
CANNOT be recovered in the revision history due to
slide revision hierarchy

1. A) TRUE
2. B) FALSE

381)

To access your form response spreadsheet from the
Edit Form page, click the ____ button.

1. A) Edit
2. B) Form
3. C) Share
4. D) View Responses

382)

Google Slides includes a number of transition choices
between slides

1. A) TRUE
2. B) FALSE

383)

Simply hit the ____ keys to create a new text document
in your Drive

1. A) Shift + R
2. B) Shift + T
3. C) Control + R



4. D) Control + T
384)

Upon form submission, responses can be collected
and displayed immediately in a corresponding
spreadsheet

1. A) TRUE
2. B) FALSE

385)

There is a limit on the number of functions in a
spreadsheet

1. A) TRUE
2. B) FALSE

386)

There is no limit to the number of people that can edit a
spreadsheet at the same time

1. A) TRUE
2. B) FALSE

387)

A student comes to you wanting to enable Offline
access in Firefox. This will work because offline access
to Google Drive is available from any web browser

1. A) TRUE
2. B) FALSE

388)

In Google Forms, if you select the option “Allow users
to edit responses”, students can modify their
responses as many times as desired

1. A) TRUE
2. B) FALSE

389)



Comments in spreadsheets can only be edited or
deleted by the owner of a spreadsheet

1. A) TRUE
2. B) FALSE

390)

The maximum number of sheets a Google Sheets
workbook can contain is:

1. A) 10 sheets
2. B) 200 sheets
3. C) 500 sheets
4. D) Unlimited
5. E) None of the above

391)

Where can the Web content features on the Settings
page be valuable in the classroom?

1. A) For visually impaired students
2. B) For young students new to web browsing
3. C) Both A and B
4. D) None of the above

392)

Students will need a Google account in order to use the
Google Chrome sign in features

1. A) TRUE
2. B) FALSE

393)

When projecting a webpage to a class, which browser
view is preferable?

1. A) Full screen view
2. B) 50% view
3. C) 25% view
4. D) View source

394)



The Chrome Extensions page allows students to do all
of the following EXCEPT:

1. A) search the Chrome Web Store for more extensions
2. B) create custom keyboard shortcuts for extensions
3. C) export extensions to other browsers
4. D) enable or disable the extension or delete the extension at anytime

395)

Students can use the bookmark bar and folders to
manage groups of web pages

1. A) related to particular units of study
2. B) related to current research
3. C) that they regularly use in class
4. D) Any/all of the above

396)

What are two sample options in the Privacy Settings on
Google Chrome that students can use to protect
themselves online?

1. A) Enable phishing and malware detection and enable the Do Not Track request
options

2. B) Use prediction services for web addresses and navigation errors
3. C) Use web services to resolve spelling errors and automatically send usage

statistics to Google
4. D) All of the above

397)

A student comes to you saying that he reset the
browser settings in Google Chrome. He is worried that
he has also deleted his bookmarks. It turns out that he
has deleted them, because when you reset browser
settings you also delete any bookmarks

1. A) TRUE
2. B) FALSE

398)



When assigning students as site owners, teachers
need to be aware that students can:

1. A) Delete the site
2. B) Change the site name
3. C) Change the site themes, and layout
4. D) All of the above

399)

When using Google Sites to publish a classroom
newsletter, you can choose different webpage layout,
such as 2 columns, from this menu when editing the
page

1. A) Insert
2. B) Format
3. C) Table
4. D) Layout

400)

You can edit the sidebar navigation from the Edit
Sidebar link in the sidebar or by clicking Manage Site
and then Site Layout

1. A) True
2. B) False

401)

With page-level permissions, you could allow all your
students to see one set of pages, allow your
co-workers to edit another set of pages, and then keep
yet another set of pages private only to yourself

1. A) True
2. B) False

402)



It is possible to blacklist an inappropriate gadget from
Google Sites

1. A) True
2. B) False

403)

By setting a student’s rights to “Can view” access to a
site, he/she can upload documents as page
attachments

1. A) True
2. B) False

404)

If you have created a standard site template for every
student in your domain to use as an individual student
portfolio the easiest way to do this is:

1. A) Share the site with every student in the domain, 50 users at a time
2. B) Make your site public to the world
3. C) Copy the site and send each student the url
4. D) Go to More -> Manage Site -> General and click on “Publish this site as a

template” and send it to the template gallery
405)

Another way to find Sites on your domain is:
1. A) Search for it in the Sites search bar on sites.google.com/a/yourschool.org
2. B) Click the “Browse Sites” link
3. C) View the full list on sites.google.com/a/yourschool.org
4. D) A and B
5. E) A and C

406)

Embedding a gadget into Google Sites means you need
to change and embed lines of code

1. A) True
2. B) False

407)



If you created a main Google Sites page called
“Student Projects” and wanted to add a sub page you
would

1. A) Select New Page, and put the page at the top level
2. B) Select Edit page, and select create a new sub page
3. C) Select Edit page, and select format
4. D) Select New page, and put it under “Student projects”

408)

Google Sites cannot be used to share calendars,
pictures, text, videos, presentations, and attachments

1. A) True
2. B) False

409)

Once a student has created a new Google Sites page, it
is NOT possible to change the page template

1. A) True
2. B) False

410)

Individuals who have ____ access can add a new post
to an announcement page

1. A) Owner
2. B) Edit
3. C) View
4. D) A and B
5. E) B and C

411)

When creating a new classroom site, which of the
following are not options?

1. A) Selecting a theme
2. B) Selecting a URL for the site
3. C) Selecting a site name that is the same as another site
4. D) Selecting a site name



412)

You can add a number of items to a Google Sites page
using the Insert menu. Which of the following items is
not an option?

1. A) Image
2. B) Google+ photo
3. C) Google Earth KML file
4. D) Presentation

413)

A site theme impacts:
1. A) Page layout
2. B) Font types and sizes
3. C) A and B
4. D) None of the above

414)

Once you have shared your site with all of your
students, it is not possible to change the sharing
settings

1. A) True
2. B) False

415)

Which of the following is NOT an item that can be
embedded into a Google Site page

1. A) YouTube video
2. B) A Word document
3. C) Images
4. D) Google Slides presentation

416)

It is possible to embed a video stored within Google
Drive in a Google Sites page

1. A) True
2. B) False



417)

If you give your students editing access to a site, they
will have the ability to delete the site

1. A) True
2. B) False

418)

If a student wants to add a hyperlink to a spreadsheet
cell that shows text instead of the URL, s/he should use
the following formula

1. A) =lookup (“website URL”, “hyperlink”)
2. B) =function (“hyperlink”, “website URL”)
3. C) =hyperlink (“website URL”, “cell text”)
4. D) =hyperlink (“website URL”, “function”)

419)

When a student wants to add an image to a document,
which of the following is NOT an option?

1. A) by URL
2. B) Import
3. C) Google Drive
4. D) Stock images

420)

In a Google Presentation, you can add a comment to
which of the following?

1. A) a table
2. B) an image embedded in your Google Presentation
3. C) a section of text
4. D) All of the above

421)

An easy way to insert an image from a webpage is to
drag it directly from the source webpage into your
presentation

1. A) True



2. B) False
422)

The spell-check tool in Docs can be launched from
1. A) edit>spelling
2. B) tools>spelling
3. C) format>spelling
4. D) none of the above

423)

Images can be added directly to a doc by
__________from the desktop

1. A) drag and drop
2. B) twist and slide
3. C) drag and insert
4. D) none of the above

424)

It is possible to create a new spreadsheet from the
mobile version of Google Drive.

1. A) True
2. B) False

425)

Speaker notes are not allowed in presentations in
Google Slides

1. A) True
2. B) False

426)

Mr. Jamison is a teacher at a school that just switched
to Google Apps. He wants upload and convert his
existing documents into Google Drive. which of the
following file type(s) can he upload and convert into a
document?

1. A) .flv
2. B) .doc



3. C) .pages
4. D) .mp4

427)

________is a simple, fast-loading view of a
spreadsheet, with basic editing, sorting, and filtering
capabilities.

1. A) list view
2. B) plain view
3. C) HTML view
4. D) basic view

428)

Which of the following can a teacher add to a
presentation?

1. A) videos
2. B) images
3. C) custom shapes
4. D) all of the above
5. E) none of the above

429)

Students with the following role(s) can make a copy of
any Google Doc, sheet, or slide presentation

1. A) editors
2. B) owners
3. C) viewers
4. D) all of the above

430)

When you add a footnote to your document, there will
be a footnote marker within the actual document
designated by a

1. A) letter (e.g. a,b,c)
2. B) *
3. C) number (1,2,3)
4. D) +

431)



The “archive” feature in Gmail moves messages out of
your inbox and into your ALL Mail label without
deleting anything

1. A) True
2. B) False

432)

One advantage of using Google+ Hangouts vs. Google
Talk is

1. A) You can chat using the Hangouts app on mobile devices
2. B) You can change your status to invisible
3. C) You can have video conversations
4. D) You can search chat history

433)

Depending on the type of mobile device you have, you
may be able to access your Gmail account via:

1. A) browser
2. B) app
3. C) sync
4. D) sms/text
5. E) A, B, and C only

434)

If two students are chatting “Off the Record”, what
does that mean?

1. A) Encrypts chats so they cannot be intercepted by others, including your domain
administrator

2. B) chats aren’t stored in your Gmail chat history, or in Gmail chat history of your
contact

3. C) Reduces the font size so those around you can not read over your shoulder
4. D) All of the Above
5. E) None of the above

435)



In conversation view, messages are stacked with the
most recent message on top

1. A) True
2. B) False

436)

You can create an unlimited number of filters
1. A) True
2. B) False

437)

With mail delegation, another person can only read and
send messages on your behalf, but CANNOT delete
them.

1. A) True
2. B) False

438)

Vacation responder in your Gmail settings will
automatically reply to anyone that email you. If that
person contacts you again after 4 days and your
vacation responder is still on, Gmail will send another
vacation response to remind the person that you’re
away from your email.

1. A) True
2. B) False

439)

In Gmail, Most Contacted in the Contacts window
includes the addresses you use most frequently. Gmail
automatically updates this list for quick and easy
references.

1. A) True
2. B) False



440)

If you no longer want to grant somebody access to
your Gmail account, you should:

1. A) delete entire Gmail account
2. B) Terminate the user from the Apps Dashboard
3. C) In the “Grant access to your account” section, click delete on any account you

want to remove
4. D) None of the above

440)

If you are searching Gmail for a message to Dana or
Mark, which of the following Advanced Search
operators would work best?

1. A) to: dana AND to: mark
2. B) to:dana OR to:mark
3. C) in:anywhere dana AND in:anywhere mark
4. D) in: anywhere dana OR in:anywhere mark

441)

Which of the following is NOT a display density setting
in Gmail.

1. A) Compact
2. B) Calm
3. C) Cozy
4. D) Comfortable

442)

If you’ve disabled Chat history saving, there will be no
record of your chat unless:

1. A) you have Cache turned on
2. B) Your domain administrator overrides your chat history settings
3. C) People you chat with save their chat histories and you are not using “Off the

Record”
4. D) A and B only

443)



Gmail will empty messages from your trash
automatically after 30 days, or you can permanently
delete messages yourself.

1. A) True
2. B) False

444)

If the guest list for a calendar invite is set to be visible,
where can you see all invitees?

1. A) Viewing event details from the calendar entry
2. B) Clicking on the event in your calendar
3. C) All of the above
4. D) None of the above

445)

As a Google Apps user, if the calendar labs tab is not
visible, a domain administrator needs to enable it.

1. A) True
2. B) False

446)

What is one way to create a calendar event that
repeats?

1. A) Right click on the event and select your preferences from the Repeat drop-down
menu.

2. B) While editing your event details, check the box Repeat…, then select your
preference from the Repeats drop-down menu.

3. C) Click “All day” even to make the event repeat.
4. D) Enter it in Quick Add and select “repeats”.

447)

When scheduling a calendar event, it is not possible to
check guest availability with Google Apps users within
your school.

1. A) True
2. B) False



448)

How do you invite guests to a calendar event?
1. A) Enter the guest email addressed into the Quick Add on the left.
2. B) Right click the calendar event and select “Add guests”. Then type in the guest

email addresses.
3. C) Click the event and edit the event details, then enter the email addresses in the

Add guests section.
4. D) Enter the email addresses of the guests in the Other Calendars list and create an

event with their calendars.
449)

One way to disable SMS notifications for a calendar is
to:

1. A) Click Settings under you’re my Calendars list and click the Notifications link for the
Calendar for which you would like to disable SMS notification.

2. B) Text “Disable” to the shortcode GVENT (48358)
3. C) All of the above
4. D) None of the above

450)

Once Calendar Labs is enabled by the domain
administrator, all labs are turned on.

1. A) True
2. B) False

451)

In calendar, the Quick Add link lets you:
1. A) Search for a calendar event
2. B) Edit a calendar event
3. C) Create an event from an email
4. D) Type a sentence to create a calendar event

452)

To use the Find the Time feature, all persons involved
must:

1. A) have access to the others’ calendar through sharing, domain level access, or
public access

2. B) be in the same domain



3. C) be in each other’s circles on Google +
4. D) Have access to the others’ calendars through Google Calendar delegation.

453)

You can print a Google Calendar in which view
1. A) Day
2. B) Week
3. C) Month
4. D) Agenda
5. E) All of the Above

454)

To set full sharing access to your calendar for only the
accounts at your school district

1. A) set it to ‘share this calendar with everyone in the domain’
2. B) set it to ‘share with the public’
3. C) set it to ‘share with a Google group’
4. D) set it to ‘see only free/busy time’

455)

Reminders for ALL Day events are received the day of
the event

1. A) True
2. B) False

456)

Only Google Apps for Education domain __________
can create a resource calendar.

1. A) principals
2. B) administrators
3. C) teachers
4. D) technology specialists

457)

To view a lesson plan calendar as a list with blocks of
time, click on the day for that lesson, then click on
______view.



1. A) full
2. B) week
3. C) day
4. D) agenda

458)

Which of these can be used for your calendar offline
1. A) iCal
2. B) Outlook
3. C) Offline Google Calendar app for Chrome
4. D) All of the above

459)

For a class calendar, you can share the calendar with
parents so they can have visibility into the class
schedule

1. A) True
2. B) False

460)

Google Calendar officially supports which two tools for
use with screen readers (for visually impaired users)?

1. A) ChromeVox and IE9/JAWS
2. B) ChromeVox and VoiceOver
3. C) ChromeVox and VoiceThread
4. D) None of the above

461)

SMS notifications are available to all countries and
languages supported by Google Apps

1. A) True
2. B) False

462)

To edit a calendar entry:
1. A) Click on the event and click on “Edit event”
2. B) Hover your mouse over the event
3. C) Double click on the event in the calendar
4. D) Both A and C



463)

One way to create a Calendar event is to click on your
Google Calendar window and fill in the dialog box. You
can then add additional event information by:

1. A) Clicking on the “Edit event” link in the dialog box
2. B) Selecting “Additional Info” from Calendar, the drop-down menu in the dialog box
3. C) Clicking on the “More” link in the dialog box
4. D) All of the above

464)

It is possible to attach a link to a Google document to a
calendar event

1. A) True
2. B) False

465)

There are many public calendars that you can add to
your Other Calendars List

1. A) True
2. B) False

466)

Calendar Labs are new _____ features and can at times
be unstable.

1. A) sample
2. B) basic
3. C) experimental
4. D) permanent

467)

You are only allowed to have one calendar with your
Google Apps for Education account.

1. A) True
2. B) False

468)



To register your mobile phone for SMS message
reminder:

1. A) Under My Calendars on the left side, click on Setting, then select to mobile setup
tab

2. B) Click on Calendar settings at the top right of any Google Calendar page, then
Select Mobile Setup tab and complete the setup

3. C) All of the Above
4. D) None of the above

469)

Which of the following is not a calendar sharing option
with teachers of your same domain?

1. A) Make changes AND manage sharing
2. B) make changes only to specific events
3. C) See only free/busy
4. D) Making changes to events

470)

In order to add event reminders to all events in a
school calendar

1. A) Click the Notifications link under My Calendars List
2. B) Click on a calendar entry, click edit event details and select “add a reminder”
3. C) Select the calendar on the left-hand side, click the drop down arrow, and select

“Notifications”
4. D) Type in “reminder” into the Quick Add

471)

When you enter someone’s email address in the Other
Calendar list, all of their calendars will appear in your
list.

1. A) True
2. B) False

472)

Copy a calendar entry to another calendar by
1. A) Right clicking an entry and clicking “copy” and then right clicking on the calendar

you would like to copy to and selecting “paste”.



2. B) You can only copy calendar events that you created.
3. C) In event details, choose the calendar you would like to copy to from the “more

Actions” drop-down menu.
4. D) A and C

473)

You can set up an Appointment Slot when you’re
viewing Calendar in _____ view or any __________view.

1. A) Day, Agenda
2. B) Month, Agenda
3. C) Week, Day
4. D) Week, Month

474)

Which of the following is not a way to view and access
your class calendar from a mobile phone.

1. A) Mobile web browser
2. B) Sync with a mobile device
3. C) Email application
4. D) SMS text message

475)

To RSVP to an event directly in your calendar follow
these steps.

1. A) Click the event and select yes, no or maybe.
2. B) Click on the event then click on “more details” and submit your response.
3. C) A and B
4. D) None of the above

476)

With multiple calendars, to create an event on one of
the calendars:

1. A) Click the drop down arrow next to the calendar, and select “Create event on this
calendar”

2. B) Search for the calendar, in the search box and click “Create event on this
calendar.”

3. C) Enter the event along with the calendar name in “Quick Add”
4. D) A and C
5. E) None of the above

477)



If you embed a restricted calendar in a public Google
Site, everyone will be able to view the calendar date.

1. A) True
2. B) False

478)

If you are looking for an old Chat with a colleague
named Chris regarding parent conferences, which of
the following is the most accurate search operator to
use:

1. A) in:anywhere Chris parent conferences
2. B) label:Chats Chris parent conferences
3. C) label:Chats Chris
4. D) label:Chats parent conferences

479)

In order to have email adddresses autocomplete in the
To: field of Gmail, you must first manually load them as
a Contact

1. A) TRUE
2. B) FALSE

480)

A student can create a task from an email in your inbox
by:

1. A) Selecting the email messages, clicking on the Move To button and selecting “Add
to Tasks”

2. B) Dragging the email message to Tasks
3. C) Selecting the email message, and clicking on the More button and selecting “Add

to Tasks”
4. D) All of the above
5. E) None of the above

481)



Office mail will only be available if your Google Apps
for Education domain administrator has enabled
“Offline Gmail” for your domain

1. A) TRUE
2. B) FALSE

482)

All teachers in Google Apps for Education domain
automatically have access to labs regardless of domain
administrator settings

1. A) TRUE
2. B) FALSE

483)

If you can’t remember the email address or name of a
contact and autocomplete is not helping, you can find
them by searching for:

1. A) Place of work
2. B) Home address
3. C) Phone number
4. D) Notes you’ve entered about them
5. E) All of the above

484)

Using Gmail, not only can you receive email from
different accounts, but you can send mail from those
accounts as well

1. A) TRUE
2. B) FALSE

485)

Priority Inbox is a Gmail feature that automatically
helps you focus on your most important messages by
splitting your inbox into different sections. Which of the



following is one of the sections that can be included in
your Priority Inbox?

1. A) “Starred”
2. B) “Searched”
3. C) “Deleted”
4. D) “Labeled”

486)

Offline Chrome Apps will run without an Internet
connection and inside the the Google Chrome Browser

1. A) True
2. B) False

487)

Offline mail will only be available if your Google Apps
for Education domain administrator has enabled
“Offline Gmail” for your domain.

1. A) True
2. B) False

488)

The announcement page is page that lists ____.
1. A) Documents
2. B) Links
3. C) Comments
4. D) Posts

489)

To search for content within your sites:
1. A) Login to Google Apps for your school, click on Sites, and search in the search bar
2. B) Go to www.google.com and search for your site
3. C) Right-click the link to your site on the My Sites page and click “Search”
4. D) Do a Google Keyword search for the topic

490)



When you remove a collaborator from a private
document, the change is effective immediately and s/he
will no longer have access to the document

1. A) TRUE
2. B) FALSE

491)

If you’re using Forms to collect school assignments,
you can set an end date or time after which students
can no longer submit responses using the Forms
feature called ‘end time’.

1. A) TRUE
2. B) FALSE

492)

In Drawings, if you’re using the latest version of
Chrome, Safari, or Firefox, you also have the option of
dragging an image from your desktop and drop it
directly in the drawing canvas

1. A) TRUE
2. B) FALSE

493)

If a student wants to create a new drawing, s/he can do
so from within Docs, Sheets, or Slides

1. A) TRUE
2. B) FALSE

494)

You can use the ____ to copy and paste slides from one
presentation to another

1. A) notepad
2. B) documents clipboard
3. C) server clipboard



4. D) web clipboard
495)

Which of the following is NOT a chart type available by
default in Google Sheets?

1. A) Area
2. B) Gantt chart
3. C) Scatter
4. D) Columns

496)

A student wants to use Google Docs to edit some
existing work on his hard drive. All of the following file
formats can be converted into Google Docs EXCEPT:

1. A) .flv
2. B) .pps
3. C) .xls
4. D) .doc

497)

The following statements about publishing from Google
Drive are true, EXCEPT:

1. A) Publishing is available for documents, spreadsheets, drawings, and presentations
2. B) Publishing allows you to make your docs available as a webpage
3. C) If you send the URL of the published version of your document, spreadsheet,

presentation, or drawing to others, they won’t be able to make any edits
4. D) It is possible to publish PDFs

498)

Once a teacher submits a template to the domain’s
template gallery, she CANNOT make changes or delete
the template

1. A) TRUE
2. B) FALSE

499)



Your colleagues want to have the entire 5th grade class
(of 150 students) edit a document at the same time.
This will work, since up to 150 users can edit a
document at the same time.

1. A) TRUE
2. B) FALSE

500)

Teachers can specify which users see which pages of a
form by using the option labeled:

1. A) Grid
2. B) Scale
3. C) Help text
4. D) Go to page based on answer

501)

The day view displays events for a ____ day. The All
Day events will appear at the ____ of the day view.

1. A) single, top
2. B) single, bottom
3. C) working, side
4. D) half, bottom

502)

Your guests don’t need to be on Google Calendar or
Gmail users to receive and respond to Google calendar
invitations

1. A) TRUE
2. B) FALSE

503)

To move a calendar entry from one calendar to another
1. A) Right click on the event and select your calendar of choice calendar from the

Calendar drop-down menu



2. B) Click on settings in the upper right hand corner and select your calendar of choice
calendar from the Calendar drop-down menu

3. C) While editing event details, select your calendar of choice calendar from the
Calendar drop-down menu

4. D) Once you create a calendar entry, it cannot be moved to another calendar
504)

What is the easiest way to remove a calendar entry?
1. A) In the calendar list on the left hand side, click on the arrow drop down and select

hide
2. B) Click on the entry on the calendar, click “delete”
3. C) Do a search for it in the calendar search bar then click “remove”
4. D) Right click the entry on the calendar, click “delete”

505)

To cancel a reminder for a single calendar event:
1. A) Under the calendar list, select Settings and click on Notifications in the top right of

the selected calendar
2. B) Rich click on a calendar entry and click “Delete notifications”
3. C) While editing your event details, click “X” next to the notification to remove it
4. D) Search for the reminder in the calendar search bar and delete

506)

You can view and edit your school Apps Google
Calendar events directly in other calendar applications,
such as Apple, iCal or Mozilla Sunbird

1. A) TRUE
2. B) FALSE

507)

There is no limit to the number of people you can share
your calendar with each day

1. A) TRUE
2. B) FALSE

508)

When embedding a Google Calendar into a Google Site,
which of the following can be customized

1. A) Default View



2. B) Language
3. C) Border/Background Color
4. D) All of the above can be customized

509)

There is no limit to how many people you can invite to
a calendar event

1. A) TRUE
2. B) FALSE

510)

To edit a reminder:
1. A) Add a new calendar entry, change the reminder in the options section and check

the “Apply to all events” box
2. B) Right click the event, click “notifications”, then edit the reminder
3. C) Click on a calendar entry, click edit event details and select “change notifications”
4. D) Click on a calendar entry, click edit event details, in the options section edit the

reminder
511)

SMS verifications require a verification code to
complete setup

1. A) TRUE
2. B) FALSE

512)

In the calendar settings, in order to share a public
Google Calendar via a link, for anyone to view select:

1. A) XML icon from ‘Private Address’
2. B) Embed this calendar and copy the code snippet
3. C) HTML icon from ‘Calendar Address’
4. D) URL in ‘Calendar ID’

513)

A calendar address is the ____ address for a Google
Calendar

1. A) XML
2. B) HTML
3. C) ICAL



4. D) All of the above
5. E) None of the above

514)

In order to receive event reminders via SMS, first you
need to validate your mobile phone

1. A) TRUE
2. B) FALSE

515)

Anyone can create a new resource for your domain in
Calendar for Google Apps

1. A) TRUE
2. B) FALSE

516)

When printing a calendar, which of the following are
print options?

1. A) Set the print range
2. B) Select the font/page orientation
3. C) Declined events
4. D) Black/White
5. E) All of the Above

517)

By default, the custom view for Google Calendar shows
the next ____ days, however the custom view is also
customizable

1. A) 2
2. B) 3
3. C) 4
4. D) 5

518)

Another way to set your calendar options is by clicking
on ____ under your my Calendars list

1. A) Sharing



2. B) Details
3. C) Settings
4. D) Options

519)

The only ways to receive event reminders are through
SMS messages and emails

1. A) TRUE
2. B) FALSE

520)

The easiest way to schedule a video call with someone
through Google Calendar is:

1. A) to go to Google Plus and start a Hangout at the time your video call is scheduled
2. B) to set a Calendar reminder to remind you to go to Google Plus and start a

Hangout
3. C) to set a SMS or PopUp reminder to remind you to go to Google Plus to start a

Hangout
4. D) to create an event and click Add Video Call in the Video Call section

521)

Inviting others to events in your calendar shares your
entire calendar with all invitees

1. A) TRUE
2. B) FALSE

522)

It is not possible to view your calendar on your
computer while offline

1. A) TRUE
2. B) FALSE

523)

Only school Apps domain ____ can create a resource
calendar

1. A) Principals
2. B) Administrators
3. C) Teachers



4. D) Technology Specialists
524)

To have your Google Calendar information available on
your mobile phone’s native calendar application you
should use the following protocol(s):

1. A) CalDav
2. B) IMAP
3. C) Google Sync
4. D) A and B
5. E) A and C

525)

If a guest using another mail program (Outlook, Yahoo,
Hotmail, etc.) receives a Google Calendar invite, they
need to do the following to have their RSVP appear in
Google Calendar

1. A) Download the calendar attachment
2. B) Click on the appropriate RSVP link within the body of the email (Yes, No, or

Maybe).
3. C) Reply to the email with their RSVP
4. D) Forward the invitation to their gmail account to RSVP

526)

To add another person’s calendar alongside your own:
1. A) Search for the person in the Calendar search bar
2. B) Under Other Calendars, type the person’s email address
3. C) Create a new calendar event and edit the event details to add the calendar
4. D) Type in the Quick Add the email address of the calendar you wish to add

527)

Guests can add a note to their invite response
1. A) TRUE
2. B) FALSE

528)



If guests have turned off notifications for new events
they will not receive an email invitation even if you click
Send

1. A) TRUE
2. B) FALSE

529)

Guests invited to a calendar event can receive updates
if any changes are made to that event

1. A) TRUE
2. B) FALSE

530)

It is possible to view free/busy information for people
with Google Apps Accounts when scheduling events

1. A) TRUE
2. B) FALSE

531)

To create an All Day event from the Create link on the
left hand-side of the calendar you need to:

1. A) Check the “All Day” box
2. B) Under My Calendars, click on Settings
3. C) Set the time of the event from 8am-11pm
4. D) Click on the “Edit event details” link

532)

Which of the following can be sent as an SMS text
message to receive calendar information to your
phone?

1. A) nday
2. B) next
3. C) day
4. D) All the above

533)



You cannot change the default view of your calendar
1. A) TRUE
2. B) FALSE

534)

Gmail users can RSVP to calendar event invitations
directly in the email message

1. A) TRUE
2. B) FALSE

535)

It is possible to create a single event that has multiple
start and end times

1. A) TRUE
2. B) FALSE

536)

Once you have received your verification code to your
mobile phone, the mobile setup process for SMS
reminders is complete

1. A) TRUE
2. B) FALSE

537)

What appears from the “Find a time” tab on the event
details page?

1. A) List of all the calendars in your calendar list
2. B) Month view of guest and resource calendars
3. C) Email invitations to send to guests
4. D) The busy and available times for all guests and resources

538)

You can quickly and easily create a calendar event by
right-clicking on the date and time and following the
prompts



1. A) TRUE
2. B) FALSE

539)

It is not possible to delete or remove all Notifications
for all calendar entries

1. A) TRUE
2. B) FALSE

540)

The best way to clear a task from view in a Task List is:
1. A) Check off the task
2. B) Check off the task and select Actions > clear completed tasks
3. C) Move it to the bottom of the Task List
4. D) Place it on your calendar as an event

541)

If you only want people within your organization to
know you’re not available, you can set which option for
your Vacation resopnder?

1. A) Only send a response to people in my Contacts
2. B) Keep my status private
3. C) Only send a response to people in
4. D) Off the record

542)

Which of the following describes conversations in
Gmail?

1. A) Individual messages with the same subject line displayed throughout your inbox
2. B) Chat transcripts related to an email message or messages
3. C) A thread of messages with the same subject line
4. D) Messages that include chat discussions

543)

Filters allow teachers to handle their Gmail based on
various search criteria. Which of the following is not an
option for filters?



1. A) By sender
2. B) By message content
3. C) By message receipient
4. D) By the number of characters in the message body

544)

Depending on the type of mobile device you have, you
can access Gmail via your device’s web browser, sync
via the device’s built in email app, or through the:

1. A) Hangouts app for Android or iOS
2. B) Gmail app for Android or iOS
3. C) Message service
4. D) SMS/Text

545)

If you would prefer to use the mobile browser or email
app built into your device, you can still access Gmail
via the following with the exception of:

1. A) MAPI
2. B) IMAP
3. C) POP
4. D) HTML

546)

Tasks allow you to easily keep track of things to do
within Gmail. Which is not a feature of Tasks?

1. A) Access Tasks on a mobile device
2. B) Print your tasks
3. C) Add tasks via SMS
4. D) View tasks on your Google Calendar

547)

If you are searching Gmail for a message from your
colleague Beth that also has PDF attached, which of
the following Advanced Search operators could be
used?

1. A) from:beth has:attachment



2. B) message:beth filename:pdf
3. C) from:beth filename:pdf
4. D) to:me has:attachment

548)

Labs in Gmail are:
1. A) Are fully supported programs by Google
2. B) Contain photo editing tools and video making tools
3. C) Created by educators to add features that students can use for collaboration
4. D) Useful applications that allow you to customize your Gmail experience

549)

In a Hangout chat, clicking the gear will expose
settings for that conversation. Which of the following is
not an option?

1. A) Notifications
2. B) History
3. C) Save to Drive
4. D) Archive

550)

Martha, a student, emails you a question about
homework. To find her email in Gmail at a later date,
you can categorize those emails using:

1. A) Tags
2. B) Bookmarks
3. C) Folders
4. D) Labels

551)

All of the following are advantages of Google Hangouts
for communicating at school except:

1. A) Unification of chat, video, and audio calls
2. B) It is available on many different devices
3. C) It can be used to quickly share website links or videos
4. D) It costs less than $1 per month for a faculty member license with free access for

students
552)



Teachers can use Groups in Google Apps to create
discussion forums, differentiate instruction and share
content with students. Which of the following is a
necessary step in creating a Group?

1. A) Post a link to the group on the school intranet site
2. B) Give the group a name and description
3. C) Add at least 10 members to the group
4. D) Add a welcome presentation to the group

553)

To locate a message that was deleted in your Gmail
account within the last 30 days (and assuming the
Trash has not been emptied), your search should
include the operator:

1. A) in:everywhere
2. B) find:deleted
3. C) in:trash
4. D) inbox:trash:all

554)

What feature of Gmail will notify you when a recipient
opens an email you’ve sent?

1. A) Auto-responder
2. B) Gmail Notifier
3. C) Delivery confirmation
4. D) Read receipts

555)

What does the number in parentheses next to the Inbox
label in Gmail indicate?

1. A) The number of important messages
2. B) The total number of messages in the Inbox
3. C) The number of unread conversations in the Inbox
4. D) The number of messages received today

556)



In order to have an email address autocomplete in the
To: field of Gmail, what has to happen first?

1. A) You must add their name to the autocomplete label
2. B) You must add the address to contacts
3. C) You must know their full name and street address
4. D) You have to add their domain to the Spam settings

557)

Which of the following is not accurate when referring to
archiving Gmail messages?

1. A) A message is no longer in your Inbox view
2. B) A message is stored in All Mail for all time
3. C) A message is moved to Trash after not being viewed within 365 days
4. D) A message shows up in search

558)

A teacher wants to send her students a large file using
Gmail but receives an error when trying to upload it.
What is the reason for this?

1. A) The file has an extension of .exe
2. B) The file contains words that are flagged as inappropriate
3. C) The file name is too short
4. D) The file contains an extension of .zip

559)

When Google releases updates to Gmail, and assuming
those updates are allowed by the Google Apps
administrator for your school, how do you enable them
for your account?

1. A) Follow the directions in the support center for Gmail to download and install the
updates

2. B) Find the special email from the Google Apps administrator and open it
3. C) Install the update from the Chrome Web Store
4. D) Since Gmail is web-based, feature updates will happen automatically

560)



Priority Inbox is a Gmail feature that automatically
helps you focus on your most important messsages by
splitting the Inbox into different sections based on
message content. Which of the following is one of the
sections that can be included in your Priority Inbox?

1. A) Starred
2. B) Searched
3. C) Deleted
4. D) Labeled

561)

What does the Archive feature in Gmail do to selected
messages?

1. A) Moves messages out of your Inbox and into your All Mail label without deleting
anything

2. B) Moves messages to Trash
3. C) Moves messages to Draft
4. D) Moves messages to folders

562)

If two students are chatting “Off the Record” when
using Gmail, what does that mean?

1. A) Chats are encrypted so they cannot be intercepted by others, including your
domain administrator

2. B) Chats are not sotred in your Gmail chat history, or in the Gmail chat history of your
contact

3. C) The font size is reduced so those around you cannot read messages over your
shoulder

4. D) Chats are stored in your Gmail chat
563)

A British teacher has several students in her class
recently arrived from another country. The students
speak some English, but their parents have a very
limited vocabulary. What is the best way she can use



the features of Google Apps to communicate the
students’ progress to the parents?

1. A) Create a Google Site in English with info about class assignments
2. B) Send an email that has been translated using message translation in Gmail
3. C) Hire one of Google’s global translation team to be on a conference call with the

parents
4. D) Create a drawing in Google Drawings

564)

What Gmail lab allows you to insert pre-formatted
content into a message?

1. A) Canned responses
2. B) Duplicate Email
3. C) Quote selected text
4. D) Quick Links

565)

The principal at your school wants to be able to quickly
identify when she receives messages from the
superintendent. How can she accomplish this in
Gmail?

1. A) Configure a Hangout notification with a special sound for the superintendent
2. B) Set up SMS notifications for messages from the superintendent
3. C) Create a label for messages from the superintendent with a bright custom color

and set the label to always show in the label and message list
4. D) Keep a Hangout window open at all times to monitor emails from the

superintendent
566)

Why is the option to “Insert Files using Drive” in a
Gmail message instead of attaching a file useful?

1. A) The document is not editable by recipients
2. B) Very large files and folders can be shared with recipients
3. C) Recipients can see who else the message was sent to
4. D) These messages will not be sent to Spam

567)



When creating your unique Gmail signature, you can
insert an image in all of the following ways, except:

1. A) Drag and drop the image from your Desktop
2. B) Upload an image from your computer to Google Drive
3. C) Use an image already in Google Drive
4. D) Insert an image that is public on the web

568)

If you are searching Gmail for a message to Dana or
Mark, which of the following Advanced Search
operators would work well?

1. A) to:dana AND to:mark
2. B) to:dana OR to:mark
3. C) in:anywhere dana AND in:anywhere mark
4. D) in:anywhere dana OR in:anywhere mark

569)

To access the vacation responder and signature
features in Gmail, click the gear icon, then Settings,
and select the ____ tab.

1. A) Customize
2. B) General
3. C) Signature
4. D) Labs

570)

When does a group Hangout chat end?
1. A) When the owner leaves the chat
2. B) After 60 minutes
3. C) When any of the group clicks the X in the upper right corner of the chat window
4. D) When the last member of the group leaves

571)

To send a message to any of the contact groups you
created in Gmail Contacts, you should:



1. A) Type the name of one of the recipients in the contact group in the To: field of the
message

2. B) Begin typing the name of the contact group and Gmail will autocomplete it
3. C) Press +G to display the list of contact groups while in the To: field
4. D) Copy the names of all recipients in the To: field of the message

572)

Gmail Offline is a Google Chrome app that lets you
____ and ____ messages when you do not have an
Internet connection.

1. A) send, receive
2. B) read, manage
3. C) share, collaborate on
4. D) receive, share

573)

Besides having no fee, a benefit of Gmail for students
is:

1. A) They can be protected in a “walled garden” where limits can be placed on people
they email

2. B) They get approximately 2GB of free storage with their Gmail accounts
3. C) They cannot email at all, but they can use their accounts to open up accounts for

third-party vendors
4. D) They can create spreadsheets for to manage homework

574)

If you are unable to see the Labs tab in Gmail Settings,
even after restarting the browser, what is the most
likely way to resolve the issue?

1. A) Power down your computer completely and wait for three minutes before powering
it on

2. B) Contact a Google Apps administrator for your school–Labs are probably disabled
for your account

3. C) Check that you have Internet access
4. D) Have someone else log into your Google Account and enable Labs

575)

A clerk in the office would like to be able to have the
ability to undo sent messages. Gmail has a feature that:



1. A) Will delete messages from recipients mailboxes
2. B) Will give her a few seconds to cancel a sent message
3. C) Will prompt her to undo when she sends an attachment
4. D) Will allow her to take back a message that was sent 30 minutes ago

576)

The following are options for Gmail Offline Sync time
frames except:

1. A) Month
2. B) 3 Weeks
3. C) 2 Weeks
4. D) Week

577)

Gmail features labels for organization of messages. A
teacher can create custom labels for classes,
correspondence with the school principal, supply
orders, etc. in addition to Gmail’s ____ labels.

1. A) System
2. B) Defacto
3. C) Group
4. D) Message

578)

A teacher receives an email from a parent suggesting a
time for a meeting to discuss their child’s progress in
the class. How can the teacher add this suggested
event to their Google Calendar?

1. A) Click on the suggested time underlined in the message to add the event to their
calendar

2. B) Click More, then click Suggestion
3. C) Right click on the message and click Add to Event
4. D) Label it as a calendar event

579)

A school experiences severe weather over the course
of several days, causing the school to remain closed



for an extended period. What Google communication
tool can the teacher use to allow her students to speak
with her in real time?

1. A) Google+
2. B) Google News
3. C) Google Search
4. D) Google Voice

580)

With Gmail for mobile browsers, you can do all of the
following except:

1. A) Create and save drafts
2. B) Create labels and filters
3. C) Access attached files
4. D) Archive messages

581)

In Gmail, each task can only be assigned to:
1. A) One list
2. B) Two list
3. C) Three lists
4. D) Four lists

582)

How can a school customize the look of Gmail and
Google Apps for Education to match their school’s
branding?

1. A) They can embed Gmail in their already paid-for website content management tool
2. B) They can upload their own school logo and set background colors to match their

school colors
3. C) They cannot upload their own school logo but can use one of hundreds of logos

available
4. D) They can edit the template gallery for school documents

583)

In which way can teachers and students categorize
Gmail messages?

1. A) Tags



2. B) Lists
3. C) Keywords
4. D) Labels

584)

Messages that are ____ will not receive a reply from the
Gmail vacation responder.

1. A) Labeled
2. B) Very large
3. C) Filtered
4. D) Addressed to a mailing list

585)

When composing an email in the Gmail mobile app, you
can add a the CC: and BCC: fields by ____.

1. A) Tapping “To:” twice quickly to expose them
2. B) Tapping and holding “To:” until they appear
3. C) Adding a secocnd recipient to an email
4. D) Clicking the arrow on the “To:” line

586)

Vacation responder in your Gmail settings will
automatically reply to anyone that emails you. If that
person contacts you again after ____ days and your
vacation responder is still on, Gmail will send another
vacation response to remind the person that you are
away from your email.

1. A) 2
2. B) 3
3. C) 4
4. D) 5

587)

What Gmail feature would you use if you wanted to
send an instant message to a colleague or student?

1. A) Gmail Hangouts
2. B) Phone chat



3. C) Docs chat
4. D) Video chat

588)

How can you manually classify a message as spam in
Gmail?

1. A) Block a phishing attempt
2. B) Click the checkbox next to the message and click the Report spam button
3. C) Whitelist the message
4. D) Forward the message to your administrator

589)

Which of the following is true of Gmail Offline?
1. A) It can only be used if there is no Internet access at all
2. B) You cannot switch between Gmail accounts
3. C) A single attachment cannot exceed 5MB
4. D) All Gmail features can be used

590)

When you label one message in a conversation in
Gmail, what can you expect to happen to other
messages in that same conversation?

1. A) The label is applied to all the messages in the conversation
2. B) The label is applied to only the most recent messages in the conversation
3. C) The label will not be applied to the most recent message in the conversation
4. D) The label must be manually applied to all the messages in the conversation

591)

Why might a student have difficulty locating a message
in Gmail using the search tool?

1. A) The message is in Spam
2. B) The message was moved to the Trash
3. C) The search term is not in quotes
4. D) The message was archived

592)

To view your Hangout history, which system label
would you click?



1. A) Starred
2. B) Chats
3. C) Messages
4. D) Chat History

593)

A unique feature of the official Gmail app for iOS is
____.

1. A) Autocomplete of contact names
2. B) Attach high definition videos
3. C) Quick actions on Notification screen
4. D) Reply all as the default

594)

What can a student use to access Gmail on a
Chromebook when he is at home with no Internet
access?

1. A) A POP mail client
2. B) Mail fetcher
3. C) Offline Gmail Chrome app
4. D) Microsoft Exchange

595)

Students can use Group chat to chat with ____ other
people at the same time

1. A) 2
2. B) 3
3. C) 4
4. D) An unlimited number of people

596)

When performing a Gmail search, the results:
1. A) Will appear highlighted in yellow in the message(s) found
2. B) Will be tagged with the lable “Search results”
3. C) Will include websites matching your keywords
4. D) Will include messages emptied from Trash if it is within 30 days

597)



A student comes to you stating that she does not have
Internet at home. If she composes a message in
Gmail’s offline mode, what will clicking “Send” do?

1. A) Move the message to Drafts so you can send it when you are back online
2. B) Start the message
3. C) Place the message in your Outbox and it will be sent automatically the next time

you connect and sync
4. D) It is not possible to compose messages in Offline mode

598)

If you only want people within your organization to
know you’re not available, you can set which option for
your Vacation responder?

1. A) Only send a response to people in my Contacts
2. B) Keep my status private
3. C) Only send a response to people in
4. D) Off the record

599)

What is a reason that a teacher would start a Google
Hangout from Google+ instead of Hangouts from a
Gmail account?

1. A) Teacher can send invite outside her domain
2. B) Teacher can invite only people in their domain using Hangouts from Gmail
3. C) Teacher can send an invite to her circles
4. D) Teacher can add a phone number

600)

Before leaving on vacation, a school principal tries to
test offline Gmail knowing that he will have limited
Internet connectivity on his trip. He cannot access
offline Gmail. What is NOT a possible issue?

1. A) The Google Apps administrator for the school has disabled ‘Offline Gmail’
2. B) The principal has not installed the Offline Chrome app
3. C) The principal is not using the Chrome browser
4. D) The mailbox has too many emails to work offline



601)

A teacher is on a class trip to a mountainous region
with no Internet access. She composes a messsage on
her tablet to several parents with photos of their
children on the trip. What happens to the message
when she taps the send button?

1. A) The message remains in the Outbox until she reaches internet coverage again
2. B) The message is deleted automatically to save storage on the device if it is not sent

in 24 hours
3. C) A notification appear on the screen of her device that Gmail is unvailable due to

network conditions
4. D) The message is sent via Bluetooth

602)

You are always using the most up-to-date vesrion
1. A) It’s always up-to-date
2. B) You can enable Labs
3. C) Is available offline
4. D) It has all the same functions

603)

Gmail will empty a message from your Trash
automatically. When will the message be emptied if you
delete it today?

1. A) In 30 days
2. B) On the 1st day of the next month
3. C) On the 1st day of the next week
4. D) In 3 days

604)

To move a task from one list to another, you will need
to:

1. A) Find the task, click the right arrow to view the task details, click the ddrop down
next to “Move to list” and select the desired list for the task

2. B) Find the task, right click on the task, click on the drop down next to “Move to list”
and select the desired list for the task



3. C) Find the task, right click on the task, click on the “Actions” button, click the drop
down next to “Move to list” and select the desired list for the task

4. D) None of the above
605)

A teacher is assigned several classes in World History
to begin the school year. How can the teacher organize
his messages using labels for these classes?

1. A) Set up forwarding to his personal email account so he doesn’t miss any messages
from World History students

2. B) Create a label called “World History” and then nested labels for each section of
the class and filter messages based on class assignments

3. C) Create a custom notification for each label he creates for American History class
4. D) Set up a search that finds any messages from World History students and routes it

to a folder
606)

Why would your school’s Google Apps administrator
add Google Groups for Business instead of using the
default Groups app?

1. A) To create shared resources like conference rooms
2. B) To share Drive folders with principals
3. C) Groups for Business allows teachers to create and manage their own groups
4. D) Groups for Business is not available for Google Apps for Education accounts

607)

Security and privacy features within Gmail explicitly
include all of the following except:

1. A) Report spam
2. B) Delete this message
3. C) Report phishing
4. D) Report bullying

608)

When you delete a contact in Gmail, what else occurs
automatically?

1. A) The emails associated with that contact are archived
2. B) They are also removed from any contact groups
3. C) A notification email is sent to their address



4. D) Messages they sent will be labeled with “Removed”
609)

What happens to Gmail messages that are moved into
Trash?

1. A) The subject of the messages appears in a red font
2. B) They remain there indefinitely until you manually empty your Trash
3. C) They will remain there for thirty days and then are removed automatically
4. D) They are delete automatically

610)

Before you can begin to chat with a teacher from a
school in another country, what must you do in Gmail?

1. A) Invite them to chat
2. B) Ask them to purchase a webcam
3. C) Make sure he/she is using Chrome
4. D) Send an email to him/her

611)

If chat is enabled for your Gmail accont, what can you
do with the messages in chat history?

1. A) Forward
2. B) Label
3. C) Copy
4. D) Print

612)

What can students type to access a list of Gmail
keyboard shortcuts?

1. A) Ctrl + S
2. B) *
3. C) Shift + ?
4. D) Alt + P

613)

To remove your signature from a single message in
Gmail, simply:

1. A) Select “Blank Signature” in Settings



2. B) Uncheck the signature box at the bottom of the message
3. C) Highlight the signature at the bottom of the message and delete it
4. D) Highlight the signature text and change the font to the same color as the

background of the body of the message
614)

In Gmail Settings, a total of ____ star icons can be
enabled.

1. A) 8
2. B) 10
3. C) 12
4. D) 14

615)

You can currrently share your Google calendar with up
to ____ users per day

1. A) 50
2. B) 75
3. C) 100
4. D) 500

616)

Which of the following can be sent as an SMS text
message to receive Google Calendar information about
tomorrow to your phone?

1. A) nday
2. B) next
3. C) day
4. D) you cannot do this

617)

On Google Calendar, how would you create an “All
Day” event from the “Create” link on the left hand-side
of the calendar?

1. A) Check the “All Day” box
2. B) Under My Calendars, click on Settings
3. C) Set the time of the event from 8am-11pm
4. D) None of the above

618)



How would you set full sharing access to your Google
Calendar for only the accounts at your school or
district?

1. A) set it to ‘share this calendar with everyone in the domain’
2. B) set it to ‘share with the public’
3. C) set it to ‘share with a Google group’
4. D) set it to ‘see only free/busy time’

619)

The default Google Calendar view opens up as which
view?

1. A) Month
2. B) Day
3. C) Week
4. D) List

620)

What is the easiest way to remove a Google Calendar
event a student has made in error?

1. A) In the calendar list on the left hand side, click on the arrow drop down and select
hide

2. B) Click on the entry on the calendar, click “delete”
3. C) Do a search for it in the calendar search bar then click “remove”
4. D) Right click the entry on the calendar, click “delete”

621)

What would you select in order to share the calendar
for your school’s basketball team via a link, for anyone
to view?

1. A) XML icon from ‘Private Address’
2. B) Embed this calendar and copy the code snippet
3. C) HTML icon from ‘Calendar Address’
4. D) URL in ‘Calendar ID’

622)



Which of the following cannot be changed on a Google
Calendar if a student has the ability to modify an event:

1. A) Event time
2. B) Event location
3. C) Calendar name
4. D) Guest list

623)

In Google Calendar, how would you cancel a reminder
for a single calendar event:

1. A) Under the calendar list, select Settings and click on Notifications in the top right of
the selected calendar

2. B) Rich click on a calendar entry and click “Delete notifications”
3. C) While editing your event details, click “X” next to the notificaiton to remove it
4. D) Search for the reminder in the calendar search bar and delete

624)

In Google Calendar, calendar labs are new _____
features, and can at times be unstable.

1. A) sample
2. B) basic
3. C) experimental
4. D) permanent

625)

You can set up an Appointment Slot when you are
viewing Google Calendar in _____ view or any
__________ view.

1. A) Day, Agenda
2. B) Month, Agenda
3. C) Week, Day
4. D) Week, Month

626)



To make one of your Google Calendars completely
private (not viewable to anyone besides yourself),
which calendar settings need to be deselected?

1. A) Make this calendar public
2. B) Only share this calendar with everyone at the domain myschool.org
3. C) Hide this calendar from the list
4. D) A and B

627)

How can Google Calendar remind you about an
upcoming faculty meeting?

1. A) Sends you a message on your phone or in email
2. B) Includes a red flag on your event
3. C) Calls you on your phone
4. D) Pop up a related Google Doc

628)

How can you add a Google Calendar Event from Gmail?
1. A) Click the underlined date and time in the body of the message
2. B) Copy and paste the email into a Calendar event
3. C) Click Create Event and click From Gmail
4. D) A and C

629)

What does the “more details” link of a Google Calendar
invite show?

1. A) The webpage with the event information
2. B) The calendar of the event creator
3. C) An option to forward the event invite
4. D) The option to delete the event

630)

Another way to set your Google Calendar sharing
options is by clicking on ____ under your my Calendars
list.

1. A) Sharing



2. B) Details
3. C) Settings
4. D) Options

631)

Is there a way to embed your Google Calendar into a
website if it is another type of Wiki, such as Wikispace?

1. A) No, you can only embed Google Calendars into Google Sites
2. B) Yes, you can embed Google Calendars into any type of webpage as long as it

uses HTML iframes
3. C) Yes, but you must go to Calendar settings and set the location as your other

website address
4. D) Yes, but only with Wikispaces or a K-12 management system made for school

websites
632)

A teacher wants to share her Google Calendar publicly.
She can use all of the following format(s) to share her
calendar except:

1. A) XML
2. B) HTML
3. C) ICAL
4. D) CalDav

633)

Why would a teacher want a display their Google
Calendar in an agenda view?

1. A) To view responses from invitees for several events in one place
2. B) To view invitees for several events in one place
3. C) To get a list view of the events they have planned for a period of time
4. D) To view calendar events that have agendas

634)

What type of Other Calendars are available by default in
Google Calendar?

1. A) Teachers from other countries
2. B) Sports teams from other countries
3. C) Google+ events from other countries
4. D) Museum openings from other countries



635)

What are all the ways you access and use Google
Calendar?

1. A) Using a computer or a mobile browser
2. B) Using Chrome, Safari, or a Mobile browser
3. C) Using a computer or a mobile device and any browser
4. D) Using a computer of mobile device, and any browser or the Google Calendar app

636)

In Google Calendar, what must those using “Find a
Time” feature do?

1. A) Have access to the others’ calendars through sharing, domain level access, or
public access

2. B) Be in each other’s circles on Google+
3. C) Have access to the others’ calendars through Calendar delegation
4. D) None of the above

637)

Which of the following choices represent some print
options for a calendar?

1. A) Next 30 Days
2. B) Day, Week, and Month
3. C) My Evens
4. D) Mini Calendar

638)

Who has the ability to assign owners of Google
resource calendars?

1. A) Owners of their own calendars
2. B) Google Apps Admins
3. C) Resource Admins
4. D) School Administrators

639)



Ms. Jones would like to use her primary calendar to
keep track of personal and school events. What can
she do to help categorize her events?

1. A) Color code personal events one color and school-related events another color
2. B) Use labels
3. C) Use the reminder feature
4. D) Type a standard header for each category

640)

Can Google+ invitations in your Google Calendar be
deleted?

1. A) No, only if you have permission to edit
2. B) Yes, anyone can delete a Google+ invite if they have been invited
3. C) No, you can only remove the event from your calendar, even if you have

permission to edit
4. D) Yes, you can delete the event, with/without permission, but it will only impact your

calendar
641)

If a student had two Google Calendars and wanted to
have the same event listed on both, what would he do?

1. A) Make a copy of the event from one calendar to another
2. B) Create the event on each of the calendars, making sure that the details are

identical
3. C) Email the calendar event to himself and move the event to his second calendar
4. D) Move the event from one calendar to other

642)

Ms. Smith wants to share her Google Calendar using a
link. Where would she find her Google Calendar’s URL
address?

1. A) Calendar Location
2. B) Calendar Settings > Calendar Details
3. C) Share this Calendar
4. D) Calendar notifications

643)



One way to create a calendar event is to click on your
Google Calendar window and fill in the dialog box.
What do you need to do to add additional information?

1. A) Click on the “Edit event” link in the dialog box
2. B) Select “Additional Info” from the drop-down menu in the Calendar dialog box
3. C) Click on the “More” link in the dialog box
4. D) Click “Create Event”

644)

Mr. Myers wants to create a public calendar to keep his
students informed about upcoming assignments, but
he does not want them to type a link into the browser.
What can he do?

1. A) He can dictate a “Private address” to them
2. B) He can share the calendar with a Google Group through Calendar Settings
3. C) He can make his calendar Public, and ask students to type his full name in Other

Calendars
645)

When using the official Google Calendar Gadget to
embed a Google Calendar into a classroom Google
Site, which of the following can be customized?

1. A) Default View
2. B) Language
3. C) Background Color
4. D) HTML code of the source page

646)

How can you share your class Google Calendar with
parents?

1. A) By giving students a numerical account code
2. B) By sharing it with a non-Google account email
3. C) By changing the view option for the calendar to public
4. D) By clicking on the Share button on the upper right-hand corner and typing in their

email
647)



If a principal would like to set up a monthly event for a
faculty meeting on the faculty calendar, he/she can:

1. A) Can set up duplicate events
2. B) Set up a recurring event
3. C) Set up an appointment slot for each day
4. D) Move events from one month to another

648)

A teacher is preparing for parent/teacher conferences.
She asks for access to a resource calendar. Why?

1. A) To book shared resources
2. B) To book appointments
3. C) To set up a schedule of meetings with parents
4. D) To communicate with parents

649)

How would you add “All Day” events in the ‘week view’
of Google Calendar?

1. A) Click in the area above the list of times for the specified day and add event details
2. B) In the day view, click and drag from 8am-11pm
3. C) Select the calendar from the calendar list and click “New all day event.”
4. D) Right click anywhere on the day of the event and click “New all day event.”

650)

What is one way to create a multi-day calendar event
for a class field trip on Google Calendar?

1. A) Click Quick Add and type in “save multiple day event”
2. B) Select multiple days in the monthly calendar view located on the main calendar

page
3. C) Click on Create Multi-day event
4. D) None of the above

651)

What will the following text typed into Quick Add in
Google Calendar create: English 9 Monday at 9:00 am
repeats weekly for 40 weeks



1. A) 40 Monday events called Recurring event starting at 9am with no end time
2. B) A recurring event, every Monday, for 40 weeks, starting at 9am, called English 9
3. C) A recurring event, every Monday, called Weekly English 9, for 41 weeks, starting

at 9am
4. D) A recurring event, every Monday, for 41 dates in the series, called English 9,

starting at 9am
652)

Why would a student want to expand their Agenda view
in Google Calendar?

1. A) To view details of an event such as a Google Hangout link
2. B) To change notification settings for an event
3. C) To change labels of an event
4. D) To create an agenda item

653)

What is one reason a teacher, without Google Apps
Admin rights, would want to have multiple Google
Calendars created?

1. A) To be able to keep track of a task list
2. B) To create a resource calendar separate
3. C) To separate a classroom events calendar from a public calendar
4. D) to distinguish between categories of events

654)

Is there offline capability with Google Calendar?
1. A) Yes, but you will only see events for the upcoming day
2. B) Yes, but only to access/view existing events
3. C) No
4. D) Yes, to access and edit events

655)

How are resources identified inside of event details?
1. A) Shared Resources
2. B) Resources
3. C) Rooms, etc.
4. D) It depends on what the Google Apps Admin calls it

656)



What is an advantage for young children of using Quick
Add?

1. A) They can write few words and create an event
2. B) They can use voice to text and have their event created
3. C) They can use it to create recurring events
4. D) They can use it to keep homework tasks organized in a list

657)

In the ____ calendar settings you can add the ____ to
your Google Calendar.

1. A) Setup, weather
2. B) General, weather
3. C) Standard, climate
4. D) Basic, climate

658)

What may be occurring if you are not seeing events
appear on your Google Calendar

1. A) You have the visibility turned off for the Calendar
2. B) You have too many calendars turned on
3. C) You are in Week view
4. D) You are in Agenda view

659)

What would a teacher do if they mistakenly created a
recurring event for 20 weeks and only meant to do it for
one week?

1. A) Delete the first event instance
2. B) Delete all events in the series individually
3. C) Delete the second event occurrence and when prompted delete all following

events
4. D) Delete the first event which triggers the rest of them to be deleted

660)



Which of the following protocol(s) should you use to
have your Google Calendar information available on
your mobile phone’s native calendar application?

1. A) CalDav
2. B) IMAP
3. C) Google Sync
4. D) CalDav, IMAP, and Google Sync

661)

Why might you use Google Calendar to keep track of
when you are delivering lessons?

1. A) To allow your administrators to view upcoming lessons for observations
2. B) To share your pacing of lessons with colleagues
3. C) To create a curriculum planning committee
4. D) Both A and B

662)

What will you see when clicking on the Agenda view in
your Google Calendar?

1. A) Printer friendly page with all the events for one day
2. B) List of events with name and start and end times
3. C) A Task list
4. D) A list with details about each event

663)

What can a primary school teacher do to make her
Google Calendar more interesting for students?

1. A) Overlay calendars of interest like weather forecasts
2. B) Add flair using stars
3. C) Embed a gadget that allows for images into Google Calendar
4. D) Insert images into Google Calendar events

664)

Once a class Google Calendar has been shared, it can
be accessed in each of the following ways except:

1. A) Embedded on a class Google Sites page



2. B) As an HTML webpage
3. C) On an individual’s list of Google Calendars
4. D) Embedded in an email

665)

How would you attach a Google Drive file to a Google
Calendar event?

1. A) Click Add Attachment when creating the calendar event
2. B) Click Add Attachment on the main Calendar page
3. C) Go to Google Drive and share the document with your calendar address
4. D) Go to Google Drive, select the file, click More, and click Open With, Calendar

666)

What do the shortcuts d, w, and a represent in Google
Calendar

1. A) day, week and aggregate
2. B) day, where and add
3. C) day, week and agenda
4. D) delete, week and agenda

667)

Which of the following is not a Google Calendar
shortcut?

1. A) d for jumping to today’s date
2. B) m for going to month view
3. C) a for going to agenda view
4. D) y for going to year view

668)

Why might you choose to embed your Google Calendar
using an iframe instead of the calendar gadget?

1. A) You can add more calendars using an iframe
2. B) You can have each calendar be a different color using iframes
3. C) There are more customizable options available using iframes
4. D) None of the above

669)



Docs: How can a teacher review all stages of the
writing process to look back at the document from the
very beginning?

1. A) By using Page setup
2. B) Click on Tools, and choose Preferences
3. C) By using compact controls
4. D) By using See Revision History under the File menu

670)

Sheets: You have recorded class test results in a
spreadsheet. Which feature allows you to automatically
calculate your students’ average scores?

1. A) Format
2. B) Functions
3. C) Protected Ranges
4. D) Revision history

671)

Slides: How can you see an overview of all of the slides
in your presentation?

1. A) View the slides on the left-hand menu
2. B) Use the zoom out feature on a slide
3. C) Click Preview
4. D) Use the Publish to export feature

672)

Docs: A student is doing a report on pyramids in Egypt.
How can the student find and insert more information
about this topic in a Google Doc, without leaving the
document?

1. A) Write “Egyptian pyramids” in the document, right click and select “Find
information”

2. B) Write “Egyptian pyramids” in the document, go to the Insert menu and select
“Topic”

3. C) Select “Research” in the Tools menu, type in “Egyptian pyramids” and click “Insert
Link” on a chosen site



4. D) Select the “Find website” add-on and type in “Egyptian pyramids”
673)

Which Google tool can help a teacher collect
information from parents, including their email
addresses, to improve home and school
communication?

1. A) Gmail
2. B) Google Forms
3. C) Google Calendar
4. D) Google Sites

674)

Drawings: Which of the following is one way to use
Google Drawings in the classroom?

1. A) Create infographics for a lesson
2. B) Developing rubrics for a Google Form
3. C) Create a student survey
4. D) Create an interactive presentation

675)

Docs: A school leader has shared a link to a Doc with
faculty members. What is one reason they may need to
request access to the Doc?

1. A) The link must be activated
2. B) The visibility of the file is set to Off – only specific people can access
3. C) The link is set to public
4. D) The visibility of the file is set to Invisible

676)

Forms: Which of the following is a way to incorporate a
video of a chemical reaction into a quiz for science
class?

1. A) Check the Forms option “enable video playback in Forms”
2. B) Add video to the question content when creating a Form
3. C) Upload a video to your quiz by using the Forms API
4. D) You cannot include video in your Form



677)

Sheets: You are editing a class list and want to
separate first and last names from one cell into two
cells. Which command allows you to do this?

1. A) The Create a form tool
2. B) The Split function
3. C) The Conditional Formatting option
4. D) The pivot table report

678)

Drive: What are the options in the left-hand navigation
menu?

1. A) My Drive, Calendar, Sites, and Trash
2. B) My Drive, Incoming, Gmail, and Sites
3. C) My Drive, Recent, Contacts, and Groups
4. D) My Drive, Shared with Me, Recent, Starred and Trash

679)

Drive: A teacher has a private file that is too large to
email using Gmail. What can she do instead?

1. A) Upload the file to Google Drive and share with the recipient
2. B) Convert the file using an app first and then upload to Google Drive
3. C) Compress your file then upload to Google Drive
4. D) Publish the file from Google Drive on th web

680)

Drawings: What is the purpose of the web clipboad in
the Edit menu of Drawings?

1. A) To save screenshots of web pages to Drawings
2. B) To access Drawings both online and offline
3. C) To copy any image created in Drawings to Google Docs, Sheets or Slides
4. D) To copy the URL of your Drawing for sharing

681)

Drive: How can Google Drive help a teacher to reduce
the use of paper in her classroom?



1. A) Allows a teacher to share notes virtually instead of making copies
2. B) Allows a teacher to leave feedback on a document by printing a list of documents
3. C) Allows a teacher to share documents in a shared folder in Drive instead of a

network shared folder
4. D) None of the above

682)

Docs: What option is available to allow a teacher to
insert images into a document?

1. A) Sideload from Instagram
2. B) Search
3. C) Embed Media

683)

Slides: How can your students embed a presentation
on a webpage and share it with the world?

1. A) Format the presentation for the web
2. B) Share the presentation with a custom email address made for posting on the web
3. C) Format the playback settings and select Publish to the web
4. D) Select all slides with your cursor, then copy and paste into an HTML editor

684)

Drive: What are the benefits of using shared folders
between students and teachers?

1. A) The teacher has control of the student’s account
2. B) The folder is viewed by anyone
3. C) The files that are added to the folder inherit the same permissions of that folder
4. D) The permissions must be set every time it is shared

685)

Docs Suite: What sharing permission settings should a
student use so that two other students can make
changes to a Google Doc and their teacher can leave
notes on it?

1. A) Give the 2 students Edit rights and give the teacher Comment rights
2. B) Give the 2 students Owner rights and give the teacher View rights
3. C) Give the 2 students Comment rights and give the teacher Edit rights
4. D) Give the 2 students Owner rights and give the teacher Comment or Edit rights

686)



Docs Suite: What should a teacher do if he is worried
about losing access to the Internet during a class
project?

1. A) Set up a temporary Google Form, accessible offline
2. B) Download the Google Slides app
3. C) Make sure Google Drive settings for offline use is turned on
4. D) Craeate a Google Drive folder to collect notes offline

687)

Forms: Which of the following question types are
available?

1. A) Multiple choice; graph; choose from a list
2. B) Sum; average; time
3. C) Choose from a list; scale; grid
4. D) Date; checkboxes; piechart

688)

Docs Suite: There are a few options to insert an image
into a Google Doc. One option allows you to drag the
image from your desktop. Which browser is not
supported by Google for features like these?

1. A) Chrome 40
2. B) Internet Explorer 8
3. C) Safari 8
4. D) Firefox 38

689)

Docs Suite: Teachers can embed YouTube videos in
____ and ____.

1. A) Sheets, Docs
2. B) Slides, Drawings
3. C) Sheets, Forms
4. D) Slides, Forms

690)



Drive: samples of lesson plans, certificates,
worksheets, inventory forms, and more?

1. A) Public Templates Gallery
2. B) Google Websites
3. C) Incoming
4. D) Starred

691)

Drawings: What happens when you hold down the Shift
and drag a corner handle to resize an object?

1. A) This resizes the selection to twice its original size
2. B) The proportions of the object remain the same
3. C) That key becomes the keyboard shortcut for resizing
4. D) A border is added

692)

Drive: How can students view a video in Google Drive?
1. A) Upload the video and click Settings
2. B) Upload the video and click on Preview
3. C) Upload the video and click on View
4. D) Upload the video and click on Sort options

693)

Docs Suite: A student copies a paragraph from a
Google Doc to the web clipboard and then deletes the
doc. Is the paragraph gone forever?

1. A) Yes, the web clipboard is specific to each doc
2. B) Yes, the web clipboard is only available in the new Sheets
3. C) No, she can use Undo to retrieve the paragraph in a new doc
4. D) No, anything copied to the web clipboard is stored for 30 days from the last action

694)

Forms: After filling out a form, can a student see the
answers submitted by everyone else?

1. A) Yes, unless you turn off “Show responses”
2. B) Yes, unless you tell them to remain anonymous
3. C) No, unless you also share the corresponding answer sheet



4. D) No, the answer sheet can never be shared using Google Apps for Education
695)

Docs Suite: Which visibility would you choose to allow
as many people as possible to view a Google Doc
(given that your administrator has allowed sharing
outside of your domain)?

1. A) Docs Suite: Select “Public on the Web”
2. B) Select the “Allow anyone to edit” option under “People at your organization with

the link”
3. C) Select “People at your organization can find and access” so individuals can easily

search
4. D) Select “Anyone with the link” and then email the link to everyone

696)

Drive: If a student deletes a document using the Docs
app on a mobile device, what is true about the
document in Drive?

1. A) The doc remains available in Drive
2. B) Once the document is removed on the Docs app, it is removed from the Drive app

document list
3. C) Even if the student removes the document using the Docs app, they need to

remove it as well on your Drive app
4. D) None of the above

697)

Drive: What is the best way for a classroom teacher to
easily find specific files shared with her by students?

1. A) Create a standard file naming system for everyone in the class to use
2. B) Allow students to set all their documents to “Public on the Web”
3. C) Have your Google Apps Administrator turn sharing rights off for students
4. D) Have your Google Apps Administrator set the sharing rights for students so only

you have access
698)



Sheets: When storing test scores in a spreadsheet,
which feature allows you to automatically highlight any
cell containing a grade below 80?

1. A) Conditional formatting
2. B) Define named range
3. C) Fill color
4. D) Paste values only

699)

Docs Suite: Who can make a copy of a Google Doc?
1. A) Viewers or Owners only
2. B) Editors or Owners only
3. C) Owners, Editors or Commenters only
4. D) Owners, Editors, Commenters or Viewers

700)

Slides: On a single slide in a presentation, how can you
reveal steps for a science lab process one step at a
time?

1. A) By automatically formatting slides in your presentation
2. B) By adding Animations to display objects one at a time
3. C) By enabling auto-advance on your presentation
4. D) By displaying Revision History during your presentation

701)

Drive: How can you browse and connect apps from
within Drive?

1. A) Click on Drive settings
2. B) Click New, then More, then Connect More Apps
3. C) Click Google+
4. D) Conduct a Google Search

702)

Slides: What is the best way for a student to create a
template of a four-panel comic strip across multiple
slides?



1. A) Attach an image of four panes to the presentation
2. B) Attach an image of four panes on the Master slide
3. C) Go to the template gallery and design a template
4. D) Download a copy of a four-paned background and upload when ready

703)

Slides: Students are compiling individual slides into a
collaborative class presentation. How can the teacher
copy these slides into a master presentation?

1. A) By selecting the same presentation template
2. B) By publishing their presentations
3. C) By sharing their presentations on a Google Group
4. D) By using the Import Slides feature

704)

Forms: A Google Form can auto-generate which of the
following in a summary page?

1. A) Charts, graphs, and statistics about the response data
2. B) The IP addresses and MAC addresses of users responding to the Form
3. C) The number of times each user has viewed the form
4. D) Responses graded on a rubric you’ve created for your Form

705)

Docs Suite: When accessing docs in a mobile browser,
which of the following is true?

1. A) You can edit docs offline
2. B) You can create docs, spreadsheets, and presentations
3. C) You will be prompted to install the mobile apps for Docs, Sheets and Slides
4. D) Multiple people can edit a doc at the same time when using a mobile browser

706)

Sheets: What is the main purpose for data validation?
1. A) To control the type of data you and your collaborators enter in the spreadsheet
2. B) To automatically calculate data entered in the spreadsheet
3. C) To format data in the spreadsheet based on certain criteria
4. D) To set up notifications to collaborators whenever data in entered in the

spreadsheet
707)



Slides: How can you insert videos into a presentation?
1. A) Upload a video from your hard drive into your presentation
2. B) Embed a URL of a video stored in Google Drive into our presentation
3. C) Click Insert and select Video…from the menu
4. D) Import your presentation into YouTube

708)

Google Forms links collected data to which tool?
1. A) A Google Sheet
2. B) A Google Doc
3. C) A Google Slide
4. D) A Google Drawing

709)

Docs Suite: Using an Android smartphone or tablet, a
Google Apps user can edit:

1. A) Docs, Slides and Forms
2. B) Docs, Sheets and Drawings
3. C) Docs, Sheets and Slides
4. D) Docs, Sheets, Slides and Drawings

710)

Docs Suite: What is the maximum number of email
addresses with whom you can share a Google Doc?

1. A) 200
2. B) 150
3. C) 50
4. D) 10

711)

Docs Suite: What is displayed in a Google Doc’s
revision history?

1. A) The location and IP address of all collaborators on a Doc
2. B) A list of changes made to the Doc by its collaborators
3. C) A timeline showing when collaborators have viewed, shared or copied the Doc
4. D) A record of all collaborators’ search activities related to the Doc’s content

712)



Docs Suite: What feature is very helpful in assessing
each student’s individual contribution to a group
project?

1. A) Collaborator Tool
2. B) Revision History
3. C) Research Tool
4. D) School Gallery

713)

Sheets: How can you tell which cell is currently being
edited by another collaborator?

1. A) Any cell another user edits will be highlighted in yellow on your screen
2. B) You will receive an email notification
3. C) The cell another user is in will have a uniquely-colored border
4. D) You will be denied access to the spreadsheet

714)

Docs Suite: Can editors publish docs (make public and
searchable) to the web?

1. A) No, only doc owners are allowed to publish to the web
2. B) Yes, docs are public by default
3. C) No, docs are private to the school or district account
4. D) Yes, as long as the owner allows editors to add people and change the

permissions
715)

Docs: What Google Docs feature should two students
use to quickly communicate with one another without
saving the conversation?

1. A) Chat
2. B) Comments
3. C) Edit
4. D) Conversation

716)



Sheets: You have created a class roster in a
spreadsheet. Which feature can allow you to merge this
roster with an assignment template made in Docs?

1. A) Add-ons
2. B) Tools
3. C) Data
4. D) Format

717)

Drive: How can a student convert an assignment from a
PDF to a Google Doc?

1. A) Copy and paste the information from the PDF to a new Google Doc
2. B) The student must upload the PDF, right-click and select Open with, then select

Google Docs
3. C) The student must upload the PDF, redownload it as a Word document, and then

upload as a Google Doc
4. D) The student must upload the PDF, right-click and make a copy

718)

Sheets: What is a shortcut for inserting formulas
directly in a cell, rather than accessing the formula
menu?

1. A) Triple-clicking the cell
2. B) Pressing Ctrl + =
3. C) Typing = before your formula
4. D) Entering the function in capital letters within a cell

719)

How can a teacher directly access files they have
created in Google Apps for Education

1. A) By accessing mail.google.com
2. B) By accessing drive.google.com
3. C) By accessing plus.google.com
4. D) By accessing calendar.google.com

720)



Drive: A student is looking for a document a teacher
shared with him and it is not found, how can the
student search for the file?

1. A) Enter the search terms in the search box, and click the Search button
2. B) Click on Preview icon on the top of all the documents
3. C) Click on Sort options and your document will show up
4. D) Click on Settings and scroll down to help

721)

Drive: If a teacher deletes a folder by mistake, how can
the teacher retrieve the folder?

1. A) Click on Recent and select Restor from the menu options above
2. B) Click on Starred and select Restor from the menu options above
3. C) Click Trash and select Restore
4. D) Click Incoming and select Restore

722)

Forms: A teacher wants to rearrange the questions on
a quiz she is preparing in Google Forms, but is unable
to do so. What might be the issue?

1. A) She is editing a question and has not yet clicked the Done button for that question
2. B) She needs to remove all users she has shared the Form with
3. C) She has to make the Form live before reordering questions
4. D) She cannot change the order of questions after they have been created

723)

Which Google tool can help students best analyze
weather temperatures collected over a period of time?

1. A) Google News
2. B) Google Drawings
3. C) Google Sheets
4. D) Google Forms

724)

Drive: Why may it be important for a teacher to
customize a folder by adding a color?



1. A) It is mandated by Drive to add color
2. B) To better organize files and folders
3. C) To better share files and folders
4. D) To create folders when working offline

725)

Docs Suite: If a teacher wants to showcase their
students work on the web, what should the teacher do?

1. A) Create a presentation to showcase students work
2. B) Change share options to can view
3. C) Change share options to Public on the web
4. D) Change share options to off – specific people

726)

Slides: What is the purpose of Speaker Notes in a
presentation?

1. A) They convert text in the presentation to voice
2. B) They display your personal notes for slides while in presentation mode
3. C) They allow you to record an audio narration to your presentation
4. D) They allow view-only collaborators to comment on your presentation

727)

Docs Suite: A school secretary creates a letterhead
template in Google Docs for her colleagues to use.
Several weeks later, she receives a request from the
principal to add a fax number to the template. Which of
the following is true in this scenario?

1. A) This secretary can edit the templates within the gallery
2. B) The people who have added the template to Google Drive will need to download it

to edit it
3. C) The secretary must delete the original template and save the newly edited doc in

its place
4. D) The people who have used the template in Google Docs will automatically get the

revisions including the fax number
728)



Which Google tool can help students in different
schools across the globe work collaboratively to create
a presentation?

1. A) Google Earth
2. B) Google Slides
3. C) Google News
4. D) Google Scholar

729)

How do you publish a Google Site to the Template
Gallery?

1. A) Go to the Template Gallery and click upload to publish your site
2. B) Through Manage Site and the General tab
3. C) Through Manage Site and the Edit tab
4. D) In the Sharing Settings

730)

When creating a Google Site, what is one thing to keep
in mind abou the “fold” on a website?

1. A) Remember to keep the color black to it does not distract from your content
2. B) Keep the most important information above it
3. C) Keep all graphics on one side of the other, but not through the middle
4. D) Any navigation items should be to its left

731)

Once you have made your Google Site editable for all
of your students, how do you change the sharing
settings to “View only&qout; for two of the pages?

1. A) Enable page-level permissions, click on each page and switch to Edit to View at
the top of the screen so it applies to all students

2. B) Enable page-level permissions, select each page and click the “Change” button to
switch to Edit to View

3. C) Enable page-level permissions, select each page and change the settings for
each student from Can Edit to Can View

4. D) Enable page-level permissions, click on each page, click the “Change” button and
then select custom permissions

732)



If you create a newsletter page template for your
classes in Google Sites, how do you edit the Page
Template after you save it?

1. A) Under More actions > Page settings
2. B) You must delete the Template and create a new one
3. C) Go to Manage Site and Page Templates
4. D) Go to More and Page Templates

733)

What can a student do if they are the site owner?
1. A) Delete the site
2. B) Change the site name
3. C) Change site themes, and layout
4. D) All of the above

734)

In Sites, this gadget lets you show new posts from an
Annoucement page

1. A) Newest posts
2. B) Annoucements
3. C) Recent posts
4. D) Latest news

735)

Where would you customize the background color of a
content area gadget on a Google Site?

1. A) Edit site layout
2. B) In Manage Site, go to the General section and enter the hex code for the gadget

color you want
3. C) Edit the properties of the gadget
4. D) In Themes, Colors and Fonts enter the Hex value for the color you would like for

the Content Area Gadget
736)

If you want your Google Site to be found and accessed
only by students and teachers at your organization,



and you do not want it to be found on the web, what
visibility option should you use?

1. A) Specific accounts within your school dom ain
2. B) Your domain
3. C) Anyone with the link
4. D) Closed to the web

737)

How do you insert a YouTube Video into a Google Sites
page?

1. A) Use the embed code found with the original video
2. B) Go to Insert in the Menu Bar and select the YouTube option
3. C) Copy and Paste the Video
4. D) You can not; instead you can insert a Hyperlink to jump to the video

738)

What element of Google Sites can a student use to
create a list of pages on their site?

1. A) A table of contents
2. B) A navigation sidebar
3. C) A main menu page
4. D) A or B

739)

In Sites, if you want to allow all your students to see
one set of pages, allow your co-workers to edit another
set of pages, and then keep yet another set of pages
private to yourself all on the same site what should you
do?

1. A) Enable page-level permissions
2. B) Provide access to everyone and then individually deny access
3. C) Only the Google Apps Administrator can do this
4. D) You must give access when you create the pages

740)

How can you change a page’s location in Google Sites
once it has been created?



1. A) Click More > Move page
2. B) Automatic organization will move the page for you based on how often it is

accessed
3. C) Click More > Modify Templates >Pages
4. D) Go to Site Manager > Move Your Pages and give the page a new weight number

741)

Can you embed a video of a school function stored
within Google Drive into a Google Sites page?

1. A) No, you can only embed YouTube videos
2. B) No, you can only embed videos in Google+
3. C) Yes, under Insert > Drive > Video
4. D) Yes, but it can not be placed on a File Cabinet page

742)

If you can create a Google Site template for you
students to use, can you lock them into a theme for
their new sites?

1. A) Yes, you do so in the properties of making the Site template
2. B) Yes, all templates created in a school domain lock the theme across all pages of

the Site
3. C) Yes, but only for the Site header
4. D) No, they can change the theme, colors and fonts just like they would on any other

Google site
743)

What access does a student need to reorganize the
pages added to the Google Site sidebar navigation?

1. A) They can reorganize the pages only when they are an owner
2. B) They can reorganize the pages as long as they have been given Edit access
3. C) They can reorganize the pages as long as they have been given Edit access and

the site is set to at least “”Anyone with the Link”
4. D) They can reorganize the pages as long as they have been given Edit access and

the site is set to “”Public on the Web”
744)

What can you do if you are trying to gather information
through a Google Site that you wish to keep on file



digitally about students in your class, but you do not
want them to see each other’s responses?

1. A) Attach a questionnaire to your site which the students can print out and complete
2. B) Use a Google Form embedded into your Site
3. C) Embed a Google Spreadsheet into your Site
4. D) Insert a polling gadget

745)

What menu allows you to place gadgets into your
Google Site?

1. A) Format
2. B) Insert
3. C) Tools
4. D) Layout

746)

What is important to remember to do when embedding
a Google Calendar into a public Google Site if you want
to share the information with anyone in the world?

1. A) You need to make the calendar Public
2. B) You have to change the dimensions of the calendar
3. C) You have to change the Calendar’s time zone
4. D) You will have hit “Update” on your Calendar when adding new content

747)

How can a teacher reorganize the sidebar navigation
for their site?

1. A) Click more actions button > Change page template
2. B) Click more actions button > Edit site layout > drag and drop sidebar items to

reorder
3. C) Click more actions button > Add page > choose location and save
4. D) Sidebar items cannot be reorganized–they are in alphabetical order

748)

What can you share using Google Sites?
1. A) Calendars and pictures
2. B) Google Chat
3. C) Video games



4. D) Text messages
749)

In Sites, how do you set a page template as the default
page for each new page created?

1. A) Under More actions > Page settings
2. B) You are not able to set a page template as your default page
3. C) In the Site Layout Section
4. D) In Page Templates settings click the Set as Default button

750)

What two modes can you use when embedding a
Google spreadsheet chart in a Google Sites page?

1. A) Live, Quick View
2. B) Live, Snapshot
3. C) Snapshot, Static
4. D) Static, Dynamic

751)

How do you allow attachments and comments on
specific pages?

1. A) More > Manage site > Allow attachments and Allow comments
2. B) Edit page > Insert comment
3. C) More > Page settings > Allow attachments and Allow comments
4. D) Edit page > Insert more gadgets

752)

What are 2 tools allowing you to edit the way a gadget
is displayed on a Google Sites page?

1. A) Alignment and wrapping
2. B) Alignment and RSS
3. C) Wrappign and RSS
4. D) Size and RSS

753)



In Sites, how can you share the setup of your File
Cabinet page with other editors so they can create
something similar?

1. A) Make them editors of the page so they can copy it
2. B) Save it as a page template
3. C) Have them Subscribe to page changes
4. D) Save the site as a template for others

754)

One of your students deletes a page on their Google
Site. How can they recover it?

1. A) Only your Google Apps Administrator can recover a deleted page
2. B) Go to Revision History from File in the Menu bar
3. C) Go to Manage Site > Deleted Items, select the page and click on Recover
4. D) Hit the Undo button or Ctrl + Z (PC) Command + Z (Mac)

755)

Of the following, which is NOT editable in the “Edit Site
Layout” view in Google Sites?

1. A) Site size
2. B) Horizontal Navigation
3. C) Themes, colors and fonts
4. D) System footer

756)

How can you change the categories and description of
a Google Site once it is created?

1. A) In the General settings
2. B) In the Page settings
3. C) In the Sharing settings
4. D) In the Layout settings

757)

If a teacher deletes a Google site she is the creator and
owner of, can she still recover it?

1. A) There is no way to recover a Site once it is deleted



2. B) Yes, the teacher has to contact their Google Apps Administrator who can reinstate
the Site

3. C) Yes, the teacher has 45 days to recover the site by going to sites.google.com
4. D) Yes, the teacher has 30 days to recover the site by going to sites.google.com

758)

Page organization is an important part of using Google
Sites. If you choose not to use automatic navigation in
your navigation menu, can you manually add pages
individually to your navigation menu?

1. A) Yes, by configuring your navigation via Edit Site Layout
2. B) Yes, by changing the page template
3. C) Yes, under Themes, Colors and Fonts
4. D) Yes, under Pages through Manage Site

759)

What can you create using Google Sites that students
can copy to their own similar Sites pages?

1. A) Handout
2. B) Webpage
3. C) Template
4. D) Sample

760)

If you want to add a Google Group gadget to your
Google Sites page, what do you need?

1. A) Just the Group’s name
2. B) The web address of the Group
3. C) An image for the Group
4. D) Both an image and the URL

761)

What is the correct sequence for making color and font
changes to areas in your Google Site?

1. A) Edit page > Colors and fonts
2. B) More > Manage sie > Site layout
3. C) Edit page > Manage site > Themes
4. D) More > Manage site > Themes, Colors, and Fonts

762)



How would a teacher provide access to their Google
Site via a custom URL for his/her school

1. A) Only the Google Apps Administrator can link your site to a custom URL
2. B) Use the Google Webmaster Tools under the General settings
3. C) You can link to a custom URL under the Sharing and Permissions settings
4. D) Currently, you can not share Educator Sites via a custom URL

763)

What type of Google Site page is designed to organize
your files uploaded from your computer’s hard drive?

1. A) Webpage
2. B) Form
3. C) File Cabinet
4. D) List

764)

In Sites, if you have a page listing assignments what is
a good way to have the assignments appear on your
Home page as well, without entering the content all
over again?

1. A) You can copy and paste the content everytime you add a new assignment
2. B) Insert a Recent Post or Recent List gadget
3. C) Embed the content by using the Pages tab under Manage Site
4. D) Have the content link to both pages

765)

Which of the following is one of the main elements of a
site layout in Google Sites?

1. A) Graphics
2. B) Menus
3. C) Widgets
4. D) Page Content

766)

How would you create a new subpage off a main
Google Sites page?



1. A) Select New page and put the page at the top level
2. B) Select Edit page and select Create a new sub page
3. C) Select Edit page and select format
4. D) Select New page and move it under the main page you already created

767)

How do you embed a Google Doc into your classroom’s
Google Site?

1. A) Go into your My Drive and send the Google Doc to your Site
2. B) Use Insert on the Menu bar that appears once you are in Edit mode
3. C) Switch to HTML to insert the Google Doc’s web address
4. D) Add a new page to your Site before adding the Google Doc

768)

You want to create a standard Google Site for every
student in your domain to use as an individual student
portfolio. What can you do to save time?

1. A) Share the site with every student in the domain, 50 users at a time.
2. B) Make your site public to the world
3. C) Copy the site and send each student the url
4. D) Publish the site as a template and send it to the template gallery

769)

In Sites, what should you do if one of the words in your
sidebar navigation is so long it runs to the next line?

1. A) Change your screen resolution
2. B) Change the width of the sidebar
3. C) Change the heigh of the sidebar
4. D) Change the site settings under Manage site

770)

How do you add a news gadget to a Google Site?
1. A) Go to the site you wish to add, copy the URL and add it via a hyperlink to your site
2. B) Go to Insert and either search for a gadget or type in the URL of the gadget you

wish to add
3. C) Go to Insert and pick the gadget you want from the list under the news section
4. D) You can only add news gadget to your home page via the Format tool

771)



What can be collected automatically about a Google
Apps for Education user when submitting a Form that
has been embedded on a Site?

1. A) Their username
2. B) How many Google accounts the user has
3. C) When they became a Google Apps user
4. D) Where they are located (city) when completing this form

772)

Which of the following customizations can be made
when embedding a Google Form into a Google Site?

1. A) Type of font and color of font
2. B) Addition of a border and change of width in pixels
3. C) Addition of a background color and theme
4. D) Change to the name of the form and addition of a shortlink to the form

773)

What are different page types you can create in Google
Sites?

1. A) Photo page, File cabinet, Start page
2. B) File cabinet, Start page, Web page
3. C) Blog page, List page, Photo page
4. D) List page, File cabinet, Blog page

774)

Where on a Google Sites does the sidebar appear by
default?

1. A) Right
2. B) Top
3. C) Left
4. D) Bottom

775)

In Sites, on a File Cabinet page can you go to a folder
and add files from there?

1. A) No, you need to upload the file first and then select the folder



2. B) Yes, folders on a File Cabinet Page work similar to Google Drive
3. C) Yes, but you can only add one at a time
4. D) Yes, put a checkmark next to the folder and click the Add Files button

776)

Which is not an option when inserting an image into a
Google Sites page?

1. A) Aligment of image on the page
2. B) Size of image on the page
3. C) Wrapping text around the image
4. D) Adding a border around the image

777)

When a Google Form is embedded into a Google Site,
will all changes to the Google Form appear on the
Google Site?

1. A) Yes, but only after the owner of the Site confirms changes to the Doc
2. B) Yes, all changes will appear in the embedded Google Doc on the Site
3. C) You can not embed a Google Doc into a Google Site
4. D) No, you must embed the Google Doc again for the Site to display the most

up-to-date version
778)

In Sites, what settings include Automatic Site
navigation?

1. A) Site preferences
2. B) Site appearance
3. C) Site layout
4. D) Site content

779)

If a fellow teacher is a site collaborator on your Google
Sites can they revert back to a previous version of a
Page Template used on that site if they wish?

1. A) Yes, under Page Template Settings
2. B) Yes, but only if they are an editor
3. C) No, this can only be done if you are the owner
4. D) No, you can edit a Page Template but are unable to see past revisions

780)



Which of the following is an item that can be embedded
into a Google Site page?

1. A) A YouTube video
2. B) A Word document
3. C) An Instagram photo
4. D) An Excel spreadsheet

781)

What steps should you follow in order to add a
horizontal navigation bar to your Google Site?

1. A) Click More > Click Edit site layout > click Horizontal Navigation
2. B) Site layout > Horizontal navigation bar
3. C) Change site > Horizontal Navigation bar
4. D) Manage site > Horizontal Navigation bar

782)

In Sites, how many ways are there to add sub-menu
navigation links to the sidebar

1. A) 0
2. B) 1
3. C) 2
4. D) 3

783)

When creating a new Google Site, is it possible to use a
template from the template gallery and then change to
a blank template once the site has been created?

1. A) No, whatever template you pick when creating the site can not be changed on a
Google Apps for Educators Site

2. B) Yes, go to the More menu, Manage Site, Themes, Colors and Fonts and click
“Clear all customizations”

3. C) No, you can pick another template to apply but are unable to go back to a blank
template

4. D) Yes, go to the More menu, Manage Site, Themes, Colors and Fonts and go to
Browse more Themes to change it

784)



What option is available for notifying students, faculty
and staff of changes to a Google Site?

1. A) RSS feeds
2. B) New messages
3. C) Voice mails
4. D) Text messages

785)

Why would a teacher use a file cabinet page on a
Google Site?

1. A) Sync lessons and organize resource documents
2. B) Upload lessons and manage resource documents
3. C) Download lessons and edit resource documents
4. D) Edit lessons and replace resource documents

786)

In Sites, what kind of files can you upload onto a File
Cabinet page?

1. A) Files hosted in Google Drive only
2. B) Any type of file
3. C) Only files uploaded from your computer
4. D) Microsoft Office fiiles and Google Doc, Sheets and Slides files

787)

If a student is given “Can View” access to a Google
Site, can he/she upload documents as page
attachments?

1. A) Yes, actually all teachers and students from the school domain can upload
documents

2. B) No, only a student who is an owner or one with Edit access can upload
3. C) Yes, anyone can as long as the site is set to “Anyone with the Link” or “Public on

the Web”
4. D) Yes, as long as the site is “Public on the Web”

788)

If you wish to have editing access to Google Sites you
have created in a Gmail account or non-school related



Google account with your Google Apps for Education
account, what should you do?

1. A) Sites you have created in one Apps account always show up by default in all Apps
accounts you own

2. B) Share the site via Sharing and Permissions with your other accounts
3. C) Make sure the site is open to your school domain
4. D) Simply turn on the Access Settings under General

789)

What must a student be aware of when copying events
from one Google Calendar to another?

1. A) That the events are actually on separate dates
2. B) That the calendar events, once copied, will not change if the original event

changes
3. C) That both events will be visible to the people who have shared access to the first

calendar
4. D) That using the Copy to is different than the Duplicate Event

790)

Which of the following is not a Google Calendar
sharing option with teachers of your same domain?

1. A) Make changes and manage sharing
2. B) Make changes only to specific events
3. C) See only free/busy
4. D) Make changes to events

791)

What is one way to create a multi-day calendar event
for a class field trip on Google Calendar?

1. A) Click Quick Add and type in “save multiple day event”
2. B) Select multiple days in the monthly calendar view located on the main calendar

page
3. C) Click on Create Multi-day event
4. D) None of the above

792)



What can a teacher do if her administrator wants a
quick list of the teacher’s lessons from her lesson plan
calendar on a particular day?

1. A) Go to her Calendar list, right click on her lesson plan calendar, and click Print
2. B) Turn off the visibility of all other calendars adn go to Agenda View
3. C) Delete all descriptions on events for the day
4. D) Delete all descriptions on events for the day and select print preview

793)

How can a school administrator make use of Google
Calendar to organize faculty meetings?

1. A) Create appointment slots for attendees to RSVP
2. B) Share free/busy status of events on their primary calendar
3. C) Create a notification to remind faculty of meetings
4. D) Create an event with a description of an agenda and links to attachments

794)

To find resources that are available within a school
domain, a teacher must:

1. A) First create an event
2. B) Open Calendar Settings to see shared resources
3. C) Have access to a public calendar
4. D) Create their own calendar for resources

795)

Which of the following cannot be added to a Calendar
invite?

1. A) Event Location
2. B) Video Hangout Link
3. C) Document Attachment
4. D) Embedded YouTube Video

796)

Which of the following allows you to schedule a video
call with everyone in your personal learning community
through Google Calendar?



1. A) Go to Google Plus and start a Hangout at the time of your video call is scheduled
2. B) Set a Calendar reminder to remind you to go to Google Plus and start a Hangout
3. C) Set a SMS or PopUp reminder to remind you to go to Google Plus and start a

Hangout
4. D) Create an event and a video call link will be created automatically

797)

When editing an event, “More Actions” allows a teacher
to:

1. A) Apply a color to the event
2. B) Edit the event
3. C) Change the owner of an event
4. D) Add invitees

798)

How would you edit a Notificaiton on Google Calendar?
1. A) Add a new calendar entry, change notifications in the options section and check

the “Apply to all events” box
2. B) Right click on the event, click on “notifications,” and edit
3. C) Click on a calendar entry, click edit event details and notify the sender to edit the

notification
4. D) Click on a calendar entry, click edit event details and edit the notification

799)

Can an SMS text notification be set for a Google
Calendar event?

1. A) No, SMS text notifications are not available for Google Apps for Education
2. B) The only person who can set up SMS text notifications is the Google Apps

Administrator
3. C) Yes, SMS text notifications are available by default in the Notifications section of

an event
4. D) Yes, SMS text notifications can be set, if SMS has been enabled in Google

Calendar Settings
800)

How would you add another teacher’s Google Calendar
alongside your own?

1. A) Search for the person in the Calendar search bar.
2. B) Under Other Calendars, type the person’s email address
3. C) Create a new calendar event and edit the event details to add the calendar



4. D) Type in the Quick Add the email address of the calendar you wish to add
801)

What can a principal do in Google Calendar to allow
teachers to view who has been invited to a special
award ceremony?

1. A) Create a calendar invite and allow invitees to view the guests
2. B) Create a resource calendar for the event
3. C) Click on view more details
4. D) Make their Calendar public

802)

Google Calendar Labs always:
1. A) Appear in a new panel on the side of your Calendar
2. B) Can be disabled after being enabled
3. C) Work as described
4. D) Include a fun fact about their development

803)

How would you add another teacher’s Google Calendar
alongside your own?

1. A) Type in their email address at the top of the Other Calendars list
2. B) Type in their primary calendar’s name at the top of the Other Calendars list
3. C) Search for the person using the calendar search box
4. D) None of the above

804)

What is one feature that can only be done on a primary
calendar in Google Calendar?

1. A) Customize privacy settings
2. B) You can do everything on a secondary calendar that you can do on a primary one
3. C) Select an embed code for insertion into a website
4. D) Turn calendar views on and off

805)

Google Sites pages can be customized by the addition
of third party developer applications called

1. A) Public



2. B) Extensions
3. C) Finance
4. D) Gadgets

806)

If a team of students wants to create a Google Site
page that keeps track of all their tasks on a project
which Page Template should they use?

1. A) List
2. B) Web Page
3. C) Announcements
4. D) File Cabinet

807)

If you have copied a Google Site to a new one, can you
still access past versions of your old site on the new
one?

1. A) Yes, but you must select the Include Revisions box
2. B) Yes, this occurs by default
3. C) As long as you haven’t made any changes yet to the new site
4. D) No, you will only be able to access revisions made moving forward once you copy

the site
808)

In Sites, what mode do you need to be in to add lesson
plan files to a File Cabinet page?

1. A) Save or preview
2. B) Edit or preview
3. C) Edit or view
4. D) Save or view

809)

When creating a new Google Site, is it possible to use a
template from the template gallery and then change to
a blank template once the site has been created?

1. A) No, whatever template you poick when creating the site can not be changed on a
Google Aps for Educators Site



2. B) Yes, go to the More menu, Manage Site, Themes, Colors and Fonts and click
“Clear all customizations”

3. C) No, you can pick another template to apply but are unable to go back to a blank
template

4. D) Yes, go to the More menu, Manage Site, Themes, Colors and Fonts and go to
Browse more Themes to change i

810)

When you create a Page Template in Google Sites, how
do you apply it to new pages you make?

1. A) It will appear in the list of Page Types
2. B) Under Manage Site
3. C) Using the Site Layout feature
4. D) Go to the More menu and select Page Type

811)

If a group of students are made editors of a Google
Site, are they able to remove an attachment or
comment that they did not upload or create?

1. A) No, they can only remove attachments and comments that are their own
2. B) They can remove comments but not attachments
3. C) They can remove attachments but not comments
4. D) Yes, as long as the site is “Public on the Web”

812)

What does the More Options section allow you to do
when creating a new Google Site?

1. A) Add site categories
2. B) Add site descriptions
3. C) Add background colors, border colors, and links
4. D) A and B

813)

If you embed a Google Group onto a Google Sites
page, who can view the discussion?

1. A) Only the members of the Google Group
2. B) Anyone who has access to the Site
3. C) Only those who are editors of the Site
4. D) Only members of the Group who are also editors of the Site



814)

What three items can a guest do to an event on Google
Calendar by default?

1. A) Modify event, invite others, delete event for everyone
2. B) Modify event, see guest list, change the name of the event
3. C) See guest list, invite others, change time
4. D) Modify event, invite others, see guest list

815)

Which option would you choose to view your
classroom events in a list?

1. A) Agenda View
2. B) Month View
3. C) Day View
4. D) Special View

816)

To help a student find meanings to words in an online
article, a teacher may want to suggest:

1. A) Searching using the define: search operator in Google Search
2. B) Going to the Chrome menu and selecting the Find… option
3. C) Going to Tools > Encoding
4. D) None of the above

817)

What does the Downloads option in the Google Chrome
menu provide?

1. A) Search feature, date of download, ability to open folders on the local device
2. B) Ability to change the download folder on the local device
3. C) Ability to delete the Download folder
4. D) Ability to change the Download folder

818)

Which of the following can be done in Chrome on a
mobile device?

1. A) Sign in and sync Google Contacts
2. B) Sign in and sync offline Contacts



3. C) Sign in to sync bookmarks AND history
4. D) Sign in and sync Gmail and all files in Drive automatically

819)

How can a user log in to Chrome if they do not have a
Gmail account?

1. A) As a supervised user
2. B) Log in with any other account
3. C) You must have a Gmail account
4. D) With a Google policy

820)

In a shared device classroom model, which feature can
allow multiple users to access their own Google
Account data at the same time?

1. A) Safe mode
2. B) Privacy mode
3. C) Chrome tabs
4. D) Incognito mode

821)

How is the Search section in Chrome settings
particularly helpful in the classroom?

1. A) It allows teachers to check sources in submitted assignments
2. B) It allows teachers to set default search engines for educational use
3. C) It allows students to select apps they want to supplement instruction
4. D) It allows educational extensions to run on a Chromebook

822)

How can students use Chrome extensions to improve
vocabulary?

1. A) Use Chrome custom search
2. B) Use Google Search
3. C) Add a reputable thesarus as an extension
4. D) None of the above

823)



Why is the Web content feature particularly helpful in
the classroom?

1. A) It allows teachers to filter websites
2. B) It allows fonts to be customized for students to meet individual learning needs
3. C) It keeps browsing within the school intranet
4. D) It allows Java to run on a Chromebook

824)

What can a student do if the text on the Chrome
browser navigation menu is too small?

1. A) Zoom in
2. B) Zoom out
3. C) Minimize the screen
4. D) Change the Font size

825)

A student finds a reliable yet extensive source on
Ancient Egypt searching in Chrome. How can the
student quickly locate the section on the page relevant
to the Third Intermediate Period?

1. A) From Search
2. B) From Edit, select Find and Replace, and type The Third Intermediate Period
3. C) From Apps
4. D) From the Chrome menu, select Find, and type Third Intermediate Period

826)

A student downloads several documents while using
Chrome on a desktop. Where can the student find these
documents

1. A) Chrome menu > Downloads or chrome://downloads/
2. B) Chrome menu > settings or chrome://setting/
3. C) Chrome menu > more tools or chrome://more tools/
4. D) Chrome menu > Find or chrome://find

827)



When printing a document, a student has the option to
keep the website URL through the following option:

1. A) Selection only
2. B) Margins
3. C) Background colors
4. D) Headers and footers

828)

What is an advantage using Chrome?
1. A) Chrome is free for the first six months
2. B) Chrome is never updated
3. C) Chrome is used by many people
4. D) Users can browse confidently with privacy options, automatic updates, and

malware security built in
829)

What happens when a user chooses to “Clear all” on
the Google Chrome Downloads page?

1. A) Downloads are removed from the Google Chrome list but remain in the download
folder location on the local device

2. B) Downloads are removed temporarily
3. C) Downloads are cleared from all content and history on the device and the browser
4. D) None of the above

830)

What can a student do to keep their school account
secured when using a shared device?

1. A) Share password information only with the shared device users
2. B) Sign into a personal account
3. C) Use two step verification
4. D) Create a password with 8 characters

831)

When a student closes a window in Google Chrome,
what components are closed?

1. A) The current tab
2. B) The current window and all open tabs in that window
3. C) All open Google Chrome windows



4. D) The Google Chrome menu closes
832)

Why should students use the bookmark feature in
Google Chrome?

1. A) To make it easier for them to visit sites at a later date
2. B) To send a message to the website that they visited
3. C) To minimize the use of Tab space
4. D) None of the above

833)

Which organizational advantage can be achieved
through the Bookmark Manager?

1. A) Ability to send messages with the bookmarks attached
2. B) Ability to create a list of documents
3. C) Rearrange, rename and search bookmark folders
4. D) None of the above

834)

A German student wants to research an assignment in
his native language, but his browser is set in Spanish.
Where does the student customize his Chrome settings
to make his research more manageable?

1. A) Google Translate tab
2. B) Add additional accessibility features
3. C) Content settings
4. D) Language and input settings

835)

A teacher is concerned about installing extensions, and
wants to read reviews of the extension before
installing. What is the most efficient way to find
reviews?

1. A) On the front page of the Chrome Web Store
2. B) By performing a Google Search
3. C) On the extension overview pop up from the Chrome Web Store
4. D) In the Play Store



836)

Which options can be found in the Advanced Sync
settings?

1. A) Toolbars
2. B) Autofill, password, settings
3. C) Passwords, toolbars
4. D) Settings, toolbars, password

837)

What is one benefit of using Chrome to search?
1. A) It provides you the correct answers to questions
2. B) It limits the amount of sites that it searches based on your preferences
3. C) Google Search automatically provides recommendations that appear as you type
4. D) It allows teachers to filter websites

838)

When you sign in to Chrome, what happens
automatically?

1. A) Chrome bookmarks are synced
2. B) Offline documents are uploaded to Downloads
3. C) Previous sessions’s browsing history is cleared
4. D) Chrome settings set to a nother type device are deleted

839)

Where would a teacher go to enable spoken feedback
for a visually-impaired student?

1. A) More tools > Accessibility
2. B) Settings > Accessibility
3. C) These are managed only from the Admin Console

840)

What feature can students customize in Chrome using
a tablet?

1. A) Text color
2. B) Image capture shortcut
3. C) Text size, autofill, location settings
4. D) Icon size

841)



How can using Chrome help a student when a school’s
device is lost or damaged?

1. A) Recovery search button
2. B) Chrome settings and Drive data can be recovered by signing back into Chrome

from a new device
3. C) Having find my device turned on
4. D) Support help

842)

A student wants to return to his original Chrome
settings. Why might selecting Reset browser setting
not be the best option for this student?

1. A) Google Chrome will no longer be the default browser
2. B) Google account password will need to be changed
3. C) Extensions and pinned tabs will be disabled
4. D) Bookmarks will disappear

843)

Which option allows a student to bookmark all open
tabs to help facilitate the research process?

1. A) Home icon on the left of the omnibox
2. B) Chrome menu, bookmark, open pages to a folder
3. C) App shortcuts

844)

A user wants to set a theme when using Chrome.
Where can the Themes feature be accessed

1. A) Settings > Appearance
2. B) Settings > Edit
3. C) Profile > Settings
4. D) None of the above

845)

Students can “pin” a tab in Chrome. What are the
benefits of pinning a tab?

1. A) Makes the tab accessible on the desktop



2. B) Creates a bookmark to the tab’s website
3. C) Locks the tab to the browser window and takes away the ability to close the tab
4. D) Creates a shortcut on the desktop

846)

How does a student turn on Auto-updates in Google
Chrome?

1. A) Check the option on the Settings page
2. B) Click the update icon on the toolbar
3. C) Auto-updates do not require any action by the user
4. D) Click the update icon on the new tab page

847)

A student wants to use Google Voice Search on their
Chrome browser. Where can the student enable voice
search?

1. A) By saying “Ok Google” into a microphone
2. B) In the Search section of Chrome Settings
3. C) By rebooting the device
4. D) By typing in chrome://voicesearch in the Chrome browser

848)

Google Chrome is available for which of the following
operating systems?

1. A) Windows Phone
2. B) Android, iOS, Linus
3. C) Blackberry, iOS
4. D) Windows Phone, Android

849)

Where would you browse to install apps, extensions,
and themes?

1. A) Omnibox
2. B) Advanced Settings
3. C) Google Play Store
4. D) Chrome Web Store

850)



How can students use Omnibox as a shortcut?
1. A) To download apps
2. B) As a dictionary and a clock
3. C) To link websites to Drive
4. D) None of the above

851)

In a shared device classroom model, how would you
add another user to Google Chrome?

1. A) Under People on the Settings page
2. B) Through the Admin Console
3. C) Through Task Manager
4. D) By uploading their information in a spreadsheet

852)

What are the benefit(s) of using Google Cloud Print?
1. A) Print to any internet connected printer, Print from a mobile device
2. B) Save the print jobs
3. C) Create a list of print items
4. D) Share the print items

853)

When sending a webpage to print, a student has all of
the following options except:

1. A) Print as plain text file
2. B) Send to printer
3. C) Save as PDF
4. D) Save to Google Drive

854)

How can users of Google Chrome add a custom
overlay to enhance the look and feel of the browser?

1. A) Preferences
2. B) Themes
3. C) Views
4. D) Icons

855)



How can students rearrange existing tabs in Google
Chrome?

1. A) Right click on the tab and reload
2. B) Drag and drop the tabs in any order at the top of the browser
3. C) Unpin tabs
4. D) Right click and choose sort

856)

When signed into Google Chrome, which of the
following components will be accessible across
devices with Advanced Sync?

1. A) Apps and extensions
2. B) Task manager and extensions
3. C) Downloads and preferences

857)

What is the main difference between a Google Chrome
app and an extension?

1. A) Extensions can be downloaded and saved to a hard drive; apps can be
downloaded to laptops only

2. B) Unlike apps, the installation process for extensions takes longer and requires a
license key

3. C) Extensions increase the capability of your browser across websites, and apps are
primarily shortcuts to websites

858)

What extension(s) can a teacher use to help students
navigate faster to a long website?

1. A) gl URL shortener
2. B) Gmail
3. C) Google Hangout
4. D) Readability

859)



When students browse in Incognito mode, Google
Chrome will store which of the following components in
the web history?

1. A) Web addresses
2. B) Downloaded files
3. C) Cookies
4. D) None of the web components above will be stored in the web history while in

Incognito mode
860)

What app should be recommended to be downloaded
for direct access to Google Drive?

1. A) Doc app
2. B) Drive app
3. C) Any program from the Apps Marketplace
4. D) Themes

861)

A student stopped working because of a
non-responsive process or tab in Google Chrome.
What should the student do to continue working?

1. A) Go to the bookmarks bar
2. B) Go to the task manager
3. C) Go to the Chrome Web Store
4. D) Use Incognito mode

862)

Where would a teacher go to add additional Google
Chrome users with separate account credentials?

1. A) Chrome menu > Advanced
2. B) Chrome menu > Settings > People section
3. C) Chrome menu > More tools > Users
4. D) Chrome menu > Help > People

863)



Where would a student check the version of Google
Chrome to see if it is up to date?

1. A) History section in the Chrome menu
2. B) Bookmarks section in the Chrome menu
3. C) Recent tabs in the Chrome menu
4. D) The About section in the Chrome menu

864)

Which search operator can be typed in the omnibox to
display the correct pronunciation of a word?

1. A) PPT:
2. B) EXE:
3. C) Ok Google
4. D) Define:

865)

What options are available in clearing browsing data in
Google Chrome?

1. A) Remove desktop shortcuts
2. B) Empty the cache, Clear download history, Clear data from hosted apps
3. C) Clear download history, Remove desktop shortcuts
4. D) Clear data from hosted apps, Remove desktop shortcuts

866)

During tabbed browsing, what can a user do to allow
more space for additional tabs in a window?

1. A) Pin tabs
2. B) Close tabs
3. C) Minimize tabs
4. D) Add bookmarks

867)

What is an advantage of Chrome apps versus a
traditional desktop application?

1. A) Images are larger in Chrome
2. B) Bookmarks are set up automatically
3. C) Quicker installation and up-to-date versions



4. D) Can use tabbed browsing
868)

How does a teacher know whether their Google
Chrome browser has the latest update?

1. A) Click Help
2. B) Check About Google Chrome in the Chrome browser
3. C) Select the Chrome menu and Edit
4. D) Select Find

869)

A student is new to Chrome, where can a teacher direct
the student to access tutorials about Chrome without
going to a new site?

1. A) Google Play for Education
2. B) The Help option within the Chrome menu
3. C) Task manager

870)

How can teachers check the Google Chrome browser
update process?

1. A)
2. B) The Google Chrome website: google.com/chrome
3. C) The Chrome web store
4. D) The Chrome menu
5. E) None of the above

871)

Which of the following categories are included in the
Chrome Web Store?

1. A) Games, Education, Productivity
2. B) Sports, Settings, Productivity
3. C) Windows, Mac, Chrome
4. D) Conferences, Utilities, Education

872)



A teacher wants to print an essay to a wireless printer
from a smartphone, what does the teacher need to do?

1. A) Download the drivers
2. B) Download the extensions that supports it
3. C) Create new setting in the printer
4. D) Enable Google Cloud Print

873)

A school district has transitioned to the Chrome
browser. How can the teachers carry over their
previously used bookmarks?

1. A) Bookmarks can be cut and pasted into the Bookmark manager
2. B) Transfer bookmarks by typing in the previous browser in the Omnibox and clicking

the star icon on the right
3. C) Bookmarks can be imported via the Chrome menu
4. D) Bookmarks can be saved in Drive

874)

Where should a teacher go in Google Chrome to get
additional assistance on how to use the browser?

1. A) Google Chrome YouTube Channel
2. B) Official Google Chrome blog
3. C) Google Chrome Help Center
4. D) Google Chrome Email Hotline

875)

Where can a student save a shortcut to a website they
want to access at a later date?

1. A) Bookmark bar
2. B) Desktop, Start menu, Taskbar
3. C) Start menu, Bookmark bar
4. D) Taskbar, Bookmark bar

876)

What tool allows you to add HTML, CSS and Javascript
into a Google Sites page?



1. A) HTML widget
2. B) HTML Box tool
3. C) CSS widget
4. D) Custom Dev tool
5. E) None of the above

877)

Which is an alternative way to add a calendar entry in
Google Calendar?
A) Type the event into “Quick Add”
B) Click on the down-arrow button next to the appropriate calendar in your calendar list then
click “Create event o…..
C) Send an email with the calendar details to username+new calendar@myschool.org
D) A and B

878)

How can a teacher customize the view of their calendar
from the main Google Calendar window?
A) Create button
B) Default view
C) The small calendar in the top left-hand corner
D) Time format

879)

How can you view your Google Calendar offline?
A) iCal
B) Outlook
C) Save to Google Docs
D) Offline Google Calendar app for Chrome

880)

How can you add reminders to all events in a Google
Calendar



A) Click the Notifications link under the My Calendars list
B) Click on a calendar entry, click edit event details and select “add a reminder”
C) Select the calendar on the left-hand side, click the drop down arrow, and select “Edit
notifications”
D) Type in “reminder” into Quick Add

881)

How would you register your mobile phone to receive
SMS message reminders regarding your Google
Calendar?
A) Select the drop-down arrow next to My Calendars, select Setting, then click the Mobile
Setup tab
B) Click on Calendar settings at the top right of any Google Calendar page and select Labs
C) Say “Ok Google” set up my phone
D) Say “Ok Google” set up my phone

882)

What does the “Quick Add” link in Google Calendar
allow you to accomplish?
A) Search for a new calendar event
B) Right click anywhere on the day of the event and click “New all day event”
C) Search for a specific invite
D) Type a sentence to create a calendar event

883)

A recurring event is one where-
A) Where you can set up an unlimited amount of instances
B) You can set up monthly occurrences , but need an end date to save
C) You can assign multiple events to multiple people
D) You can set up a repeating event with a start date and end date

884)



What are three standard views in your Google
Calendar?
A) Day, Week, Month
B) Hourly, Daily, Weekly
C) Week, Month, Year
D) None of the above

885)

Why would a teacher want to set up appointment slots
on a Google Calendar?
A) To set up a meeting with their principal
B) To collect information about what a parent is contributing for a class party
C) To book a room for a meeting
D) To allow parents to select a time for a teacher conference

886)

How do you invite students to a Google calendar
event?
A) Enter the guest email addressed into the Quick Add on the left.
B) Right click the calendar event and select “Add guests”. Then type in the guest email
addresses.
C) Click the event and edit the event details, then enter the email addresses in the Add
guests section.
D) Enter the email addresses of the guests in the Other Calendars list and create an event
with their calendars.

887)

Mr. Blakeney’s students are starting to think about their
future careers and which digital classroom skills they
need to develop. Use drag and drop to separate digital
classroom skills from traditional ones
A) Remote collaboration and teamwork with multiple people for the best results –
Digital classroom skill



B) Filing paper based documents in a physical storage area for safe-keeping –
Traditional classroom skill
C) Finding the best online resource, information and method to solve a problem –
Digital classroom skill
D) Storing documents in the cloud for easy retrieval and editing – Digital classroom
skill
E) Working in groups in-person during set hours to collaborate on a joint project –
Traditional classroom skill
F) Communicating to a wide audience by publishing work online – Digital classroom
skill
G) Pinning printed projectts in wall displays around the school – Traditional
classroom skill

888)

Mr. Yarmouth needs to contact a student’s parents to
congratulate the student on improved progress.
However, their first language is German and they are
not fully fluent in English. What is
A) Post the message text on Google+ to see if someone can help translate to German
B) Use Gmail to send a message around the school to search for a student who can help
translate the email to German
C) Use Google Search to find someone local offering German translation services to help
with the email
D) Search the Chrome Web Store for the Google Translate extension for Chrome. Use
the extension to provide a German version of the text within the email

889)

Students should use the right tools for each of their
classroom tasks. Match the most appropriate Google
tool for each task by moving the rows up and down.
A) Data analysis and organization for market research projects = Sheets
B) Viewing assignment details and turning in work digitally = Classroom
C) Creating images, charts, and mindmaps = Drawings
D) Online research for an essay = Search
E) Creating a group presentation = Slides
[youtube https://www.youtube.com/watch?v=h405GYKXvFs?feature=oembed]



890)

Mr. Swanson’s politics students had to create a blog
about politics if they were selected to be on the
school’s student council. One student received a nasty
response from an online user she didn’t know. What
advice should Mr. Swanson give her to overcome this
type of response?
A) Block the person from accessing the blog
B) Check and change privacy settings on her blog to see if she had shared it with just
members of her school or with the public
C) Search for the user through other online networks and retaliate there
D) Document the user’s details
E) Report the incident to a member or staff if it happens again
F) Respond directly to the person and challenge their comments
891)

Mr. Bailey is a school IT teacher and has heard that he
can access support from Google for Education
specialists to help him understand and explore the
benefits of Google for Education and Chromebooks.
Match the different support options he can access with
their definitinos by moving the rows up and down.
A) Google for Education partners = Organizations that provide services to schools and other
educational institutions, that can include hardware sales, deployment support and
professional development
B) Google for Education Certified Trainers = Authorized professionals vetted by Google to
provide professional development and training services on Google for Education tools
C) Reference Schools = A school or district willing to connect with others to provide advice
and support on best practices, deployment and professional development
D) Google for Education Certified Innovators = Certified educators who inspire other
educators to use technology to transform their teaching methodologies
892)



Mrs. Powell is looking at ways to reduce the amount of
printing undertaken in class. How can Google Drive
help?
A) Google Drive can be configured so the printing of files in class is password protected
B) All class print requests can be rerouted in Google Drive to the school office
C) Files in Google Drive can be shared with a simle link in an email. No need to print a copy
for someone in class
D) Google Drive makes files easily accessible from anywhere, so there is less need to print
and carry documents into class
E) Google Drive can automatically reformat documents before printing to save on paper
893)

Mr. Kapoor struggles to find inspiration from his peers.
What is one benefit of establishing a Personal Learning
Network (PLN)?
A) By forming a Private Learning Network, he would get access to an exclusive website that
allows for cloud-based resource sharing and messaging between local educators
B) By joining a Professional Learners’ Network, he would get access to teacher training
courses, and join regular seminars conducte by teacher training specialists
C) By establishing a Personal Learning Network, he would develop links with other local and
non-local educators to share ideas and best practices, and to call upon for teaching advice
D) By subscribing to a Professional Learning Network, he would get paid access to
educational material and advanced digital teaching tools
894)

Mr. Hoffman is using Google Slides to introduce a new
class project. He wants to embed and link to Docs,
Forms and Drawings in order to make his slides more
interactive. Use drag and drop to match the Google app
with a way that it can be used within Slides to
encourage student participation.
A) Rate the content that is being presented – Google Forms
B) Additional reference material – Google Docs
C) Suggestion notepad – Google Forms
D) Gauge understanding – Google Forms
E) Graphically design ideas – Google Drawings
895)



Ms. Jones has divided her class into groups to work on
different geography projects. Each group will present
their project to the class using Google Slides. What are
some benefits of using Slides in the classroom?
A) Students can import and edit a video directly in a slide without additional software
B) Students can export the completed presentation as a flash animation
C) Students can make their own copy of the slide deck from a shared link
D) Students can collaborate on the slide deck at the same time
E) Students can browse and copy slides created by any student at any other school
896)

Mr. Brixham is the principal at a large school and
receives an overwhelming volume of emails from
teachers, support staff, students, parents, and the
school district governors. He often struggles to find
important emails quickly. How can he use the search
function in Gmail to locate emails more efficiently?
A) Search for emails containing hyperlinks
B) Filter emails that have attachments
C) Search for emails within a label
D) Search for emails by sender or recipient
E) Search for keywords within emails
F) Filter emails by word count
897)

Ms. Dent wants to use Google Forms and Google
Sheets to collect and track different aspects of her
students’ work. Use drag and drop to show how she
could use these Google tools efficiently.
A) Create a gradebook to track student scores = Sheets
B) Check class understanding of a topic = Forms
C) Protect collected data from change = Forms
D) Collect anonymous feedback = Forms
E) Analyze trends on a record of books read by students = Sheets
898)



Ms. Villagarcia has been tasked by the principal to
improve communcation and discussion between
teachers and support staff. What is the most
appropriate tool to fulfill this need?
A) She can use Google Sheets to take minutes during faculty meetings and share them with
participants and missing faculty members
B) She can use Google Drive to create a shared folder containing school admin and policy
documents, useful templates and other shared resources
C) She can use Google Sites to build a website containing all of the school’s policy
documentation and set up a contacts page so staff members can send their comments
directly to her to distribute to relevant people
D) She can use Google Groups to easily create an online discussion forum and invite all
relevant people to start conersations and participate in different discussion topics in one
accessible place
899)

Mr. Bentley finds it easy to use Google Docs, Sheets,
and Slides in his classroom as they are very similar to
other programs he’s used in the past. He overhears his
colleague Ms. Bernard talk about using Google Forms
as well, but isn’t sure how it’s relevant in a school
environment. Which of the following are relevant uses
for Google Forms in education?
A) Performing basic calculations with numeric data
B) Creating an interactive presentation
C) Surveys for collecting data for group projects
D) Create formative quiz checks at the end of each lesson
E) Gathering feedback on field trips
F) Designing a logo for a school football team
900)

Mr. Murakami leaves written notes with motivational
quotes for his students by writing them on paper and
leaving them in different locations in his classroom.
Occasionally his students will claim they didn’t get a



note or admit they lost it. What can he to do overcome
this issue and still send these motivational messages?
A) Use Calendar to set up a task calendar for deadlines
B) Use Groups to send group messages to all students in his class
C) Use Hangouts to video call his students when he needs to talk to them urgently outside of
school hours
D) Use instant messaging in Hangouts to send messages directly to students, which can be
received on a PC or through a mobile app
E) Use YouTube to send links to relevant videos to help with their research
901)

Students in your biology class sometimes struggle to
understand biological processes, like digestion. What
digital activities can help get students more involved in
exploring a process?
A) Information can go out of date very quickly – Textbook
Information can be accessed by anyone, anywhere – Digital Content
Additional information can be found to support the primary subject for a better understanding
– Digital Content
Information is continuously being updated – Digital Content
A finite number of copies so students may need to share – Textbook
Physical damage can make content unusable – Textbook
Vast amount of information available on a given topic – Digital Content
School policies can restrict the removal of school property from the site – Textbook
Multiple sources available to verify and challenge information – Digital Content
Limited amount of information on a given topic – Textbook
B)
902)

Students in your biology class sometimes struggle to
understand biological processes, like digestion. What
digital activities can help get students more involved in
exploring a process?
A) Students create a diagram in Google Drawings to explain the biological process
B) Students use Google Search to research the subject
C) Teacher shares work completed by students the previous year that is shared on a Google
Site
D) Teacher gives students relevant textbook chapters to research the subject
E) Students print their findings and paste it in their workbook



F) Teacher provides useful videos in a YouTube playlist
G) Students create a group presentation in Slides to present their findings to the rest of the
class for discussion

903)

Ms. Pietersen is the deputy principal in a school split
across two sites. She travels regularly between the two
sites by bus, but is annoyed with the amount of time
she wastes traveling. She would like to make a better
use of her commute time. What can she do?
A) She can use the Offline View app on her smartphone to download an offline version of all
unread emails so she can read her emails while traveling
B) She can use the Gmail mobile app on her smartphone to access her school email
account to read, send, and reply to emails
C) She can turn on the Agenda app on her PC before she travels, which will sort her tasks
and meetings while she’s traveling and arrange them in priority order when she’s back at her
PC
D) She can use the YouTube app on her smartphone to listen to music and use that time to
relax between on-site meetings
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